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Description of menus and buttons

In the event that menu and button names on a Windows
system are different from those on a Mac, this manual
uses the Windows menu and button names followed by the
Mac menu and button names in parentheses.
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Getting Started

Overview of M7CL V3 Editor

M7CL V3 Editor (hereinafter called “M7CL Editor” in this document) enables you to remotely control a Yamaha
M7CL mixing console (Version 3) (such as M7CL-48ES, M7CL-48, or M7CL-32; hereinafter collectively called
“M7CL” in this document). M7CL Editor also enables you to save the parameter settings on your computer. To use
M7CL Editor, you must first perform the following operations:

1 Start and configure Studio Manager.
2 Start and configure M7CL Editor.

3 Synchronize M7CL Editor with your M7CL console (= p.12).
o573l For more information on using Studio Manager, refer to the Studio Manager Owner’s Manual.

Configuring M7CL Editor

You must configure the following settings for each open Editor.

573 e Before you make the following settings, you must make settings for the DME-N Network Driver (Windows)
or the Network-MIDI Driver (Mac) and select the MIDI port in the Setup window of Studio Manager.

 To open an editor, double-click the icon for the desired editor in the Studio Manager window.

(ASystem Setup
To open the System Setup dialogbox, choose [System Setup] from the [File] menu.
Be sure to specify the Input port and Output port.
(D Input port/Output port
From the ports you specified in Studio Man-

ager, select the ports that the editor will use
to communicate with the M7CL console.

(@ Model Select
This section enables you to make settings for
the M7CL model yOu are using. Stage Box Data Conwersion Conwversion...

M7CL-32/M7CL-48/M7CL-48ES

Select the model of your M7CL. If M7CL
Editor is synchronized with the M7CL con-

& System Setup ==
St [ |

— Cutput port T CL—48 E|

P

—— Model Select
MICL-32 @ MTCL-48 MTCL—423ES

—— Channel Selact / Sends On Fader

Link between the FC and the console

sole, the model will a.utoma‘tically be selected _Fist ::::e Djnﬁ:;tj;onﬁrma“on @

and other model options will be grayed out. el Gonfrmation

Stage Box Data Conversion | window Contral From Ganeale Fstch Donfirmstion

Converts HA settings and input patch set- 7] Enable 7] Steal Patoh Gon firmation

tings accordingly if, for example, you want to

use (on an M7CL-48ES system) data stored _LE“E'E""E:I” e ——(8)
J| Enable

by a system that features SB168-ES units
connected to M7CL-48 slots.

Click the [Conversion...] button to display
the Stage Box Data Conversion dialog box for
conversion. (= p.8)

T 99 P9

[ 5etDefault [ oK I | Cancel |
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(3 Channel Select / Sends On Fader

This checkbox enables you to specify whether or not the M7CL console and M7CL Editor are linked to each other
for the following operations:

* Selecting channels

+ Switching between normal mode and SENDS ON FADER mode

+ Switching between MIX and MATIRX in SENDS ON FADER mode

If you do not check the box, the M7CL console and M7CL Editor will operate independently.

(@ Fast Sync

This allows synchronization to be speed up, reducing the time required. Check this box to enable the function.

(& Window Control From Console
This option determines whether or not using the USER DEFINED KEYS on the console enables you to remotely
open and close the M7CL Editor windows.

(® Level Meter

By disabling the meter function you can reduce the processing load caused by screen drawing and communica-
tion. This option specifies whether the level meter functionality will be enabled.

(@ Confirmation
These check boxes specify whether a confirmation dialog box will appear when you store (Store Confirmation),
recall (Recall Confirmation), patch (Patch Confirmation), or make a patch change that would modify an existing
patch (Steal Patch Confirmation).

Administrator Password

Enter the Administrator password that was specified on the M7CL console. If this password is not entered cor-
rectly, it will not be possible to synchronize from M7CL Editor to the M7CL console.

(@ Set Default

Press this button to use the settings currently specified in the System Setup dialog box as the default settings. The
next time when you start up M7CL Editor, it will use these settings.
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dMixer Setup

To open the Mixer Setup dialogbox, choose [Mixer Setup] from the [File] menu.

& Mixer Setup (=]
@—— Mix Busz Setup
Signal Type Bus Type/Send Point Fan Link
Mix 1 /2 FOMD:2 E WARIFRE FADER) E
Mz 3 £ FADI NI 322 E WARIFRE FADER] E
Mix 5 /6 FAONO2 E WARI(PRE FADER) E
Mix 7 /3 MO RO 2 E WARI(PRE FADER) E
Mix 9410 FDMD:2 E FIXED E
Mz 11412 STERED E WARIFRE FADER] E
Mis 13514 FAONO2 E WARIPRE FADER) E
Mix 15416 STERED E FIXED E
@—— Matriz Bus Setup
Signal Type Send Paint Pan Link.
for Input Channels
Matrix1 /2 MO RIO 2 E PRE FADER E
Matriz 3/4 FAD RO 2 E FRE FADER E
Matriz /6 STERED E FRE FADER E
Matriz 7/ STERED E PRE FADER E
E Ok i | Cancel |

(1) Mix Bus Setup

Here you can make settings relating to the MIX buses.

Signal Type: Choose either MONOx2 or STEREO for each two adjacent odd-numbered/even-numbered MIX
buses.

Bus Type/Send Point: Choose either VARI (PRE FADER) or VARI (PRE EQ) or FIXED for each two adja-
cent odd-numbered/even-numbered MIX buses.

Pan Link: The PAN setting for signals sent to stereo MIX buses will link to the PAN setting for the STEREO bus.
This parameter is valid only if the Signal Type is set to STEREO and the Bus Type is set to VARI.

(@ Matrix Bus Setup
Here you can make settings relating to the MATRIX buses.

Signal Type: Choose either MONOx2 or STEREO for each two adjacent odd-numbered/even-numbered
MATRIX buses.

Send Point for Input Channels: Choose either PRE FADER or PRE EQ for each two adjacent odd-num-
bered/even-numbered MATRIX buses.

Pan Link: The PAN setting for signals sent to stereo MATRIX buses will link to the PAN setting for the STEREO
bus. This parameter is valid only if the Signal Type is set to STEREO and the Bus Type is set to VARI.
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dCreating a user key
To open the Create User Key dialogbox, choose [Create User Key] from the [File] menu.

This creates a user key (with “M7U” file name extension) that can be read from a USB storage device by the

M7CL console to automatically set user-specific parameters.

i

® ®

i
i

& Create User Key (23]
User Name Comment FOWER USER J
Password Re—Enter Password Administrator Password
@—— ACCESS PERMISSION
CH OPERATION Set Al | | Clear Al | CURRENT SCENE
INPUT
IMFUT INPUT
@ 1 2 3 4 5 [ 7 g ] 10 11 12 13 14 15 16 PATCH FAME
BUS
17 18 13 20 2 22 23 24 25 26 27 28 23 30 3 32 e e —r
33 34 35 36 37 38 33 40 41 42 43 44 45 45 47 43 = e
STIM DCA
@ 1L 1R 2L 2R 3L 3R ETH 4R 1 2 3 4 5 [ 7 g @
i [ FLATH 1 ” FLATH, 2 ” FLATK, 3 ” RLATH, 4 ]
1 2 3 4 5 [ 7 g ] 10 11 12 13 14 15 16 IRACKS ” RACK 6 ” RACK T ” RACK & ]
MATRIX ST/MOND
1 2 3 4 5 [ 7 g STEREOD L STERED R MONOS)
e MUTE GROUF MUTE GROUF
Set by One Click Hit EROCESSING FADERSON ASSIGN MASTER
SCENE LIST FILE LO AD MOMITOR SETUP
STORE SYSTEM SETUP @
@ bl RECALL USER SETUR T RS OSCILLATOR [ TALKEACK ]
LIBRARY LIST SYSTEM SETUP
STORE CURREMT SCENE LIERAR'T MIXER: QUTFORT @
@ FOLEAR BECALL SCEME LIST LIST SETUF SETUF [ ll=? ]
I Create I | Cancel |

Specify the name of the user. You can enter up to eight single-byte alphanumeric characters. Lowercase characters
will automatically become uppercase on the M7CL console.

@ Comment
Enter a comment for each user. You can enter up to thirty-two single-byte alphanumeric characters.

(3 Password
Enter a password that will be used when this user key is read by the M7CL console. You can enter up to eight sin-
gle-byte alphanumeric characters. Uppercase and lowercase are distinguished.

(@ Re-Enter Password
Enter the password once again as a safeguard against mistaken entry.

& POWER USER
Specify whether this user is a power user. Power users can use the M7CL console to create or edit a user authenti-
cation key with a specified user level.

(6) Administrator Password
Enter the Administrator password that was specified on the M7CL console. This is not required if no Administra-
tor password has been specified on the M7CL console, but if this password is incorrect you will be asked to enter
it when the user key is read.
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(» ACCESS PERMISSION

In this area, specify the parameters that this user will be allowed to operate.

CH OPERATION
INPUT, ST IN, DCA, MIX, MATRIX, ST/MONO: Select the channels whose parameters will be opera-
ble.

HA: Change the operating privileges for the head amp gain and phantom power of the selected channels.

PROCESSING: Change the operating privileges for overall signal processing parameters (except for fader
and [ON] key) of the selected channel. For the specific parameters included in PROCESSING, refer to the
appendix of the M7CL owner’s manual.

FADER/ON: Change the operating privileges for the pan/balance, fader, channel on, send on/off, and send
level of the selected channels.

Set All: Turn on HA, PROCESSING, and FADER/ON for all channels.
Clear All: Turn off HA, PROCESSING, and FADER/ON for all channels.

Set by One Click: If this button is on, pressing the channel select button repeatedly will set HA, PRO-
CESSING, and FADER/ON to On or Off simultaneously.

(@ SCENE LIST
STORE/SORT: Change the operating privileges for scene store and sort operations.
RECALL: Change the operating privileges for scene recall operations.

LIBRARY LIST
STORE/CLEAR: Change the operating privileges for library store and clear operations.
RECALL: Change the operating privileges for library recall operations.

i) FILE LOAD
USER SETUP: Change the operating privileges for loading user-defined keys and preferences when loading a
file.

SYSTEM SETUP MONITOR SETUP: Change the operating privileges for loading system setup and moni-
tor setup settings when loading a file.

CURRENT SCENE: Change the operating privileges for loading the current scene when loading a file.
SCENE LIST: Change the operating privileges for loading the scene list when loading a file.
LIBRARY LIST: Change the operating privileges for loading the library list when loading a file.

(2 CURRENT SCENE
INPUT PATCH: Change the operating privileges for input patch operations.

INPUT NAME: Change the privileges for editing the input names.

OUTPUT PATCH: Change the operating privileges for output patching.

OUTPUT NAME: Change the privileges for editing the output names.

BUS SETUP: Change the operating privileges for buses.

RACK 1-8: Change the operating privileges for rack operations.

MUTE GROUP ASSIGN: Change the privileges for assigning mute groups.

MUTE GROUP MASTER: Change the operating privileges for enabling/disabling mute groups.

(3 MONITOR SETUP
OSCILLATOR: Change the operating privileges for oscillator settings.

TALKBACK: Change the operating privileges for talkback settings.

SYSTEM SETUP
MIXER SETUP: Change the privileges for making mixer setup settings.

OUTPORT SETUP: Change the privileges for making outport setup settings.
MIDI: Change the privileges for making MIDI settings.

(5 Create

Creates the user key.

Cancel
Closes the dialogbox.
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Working with Sessions

All of your console’s mix settings in M7CL Editor, including Scene and library data, are called Sessions.

The following table describes how to handle Sessions.

Creating a new Session

Choose [New Session] from the [File] menu.

Opening a previously saved Session

Choose [Open Session] from the [File] menu.

Saving the current Session

Choose [Save Session] from the [File] menu.

Saving the current Session with a new name Choose [Save Session As...] from the [File] menu.

When you save a session in the window of an editor, the settings of only that editor will be saved in a file. Session files
saved by M7CL Editor have a filename extension of “YSE”. Files in which only the M7CL console data is saved (file-
name extension “M7C”) can also be handled, allowing you to use a USB storage device to exchange data with the

M7CL console.

If you save a Session in the Studio Manager window, all selected Editor settings are saved in a file with a file extension

of “YSM.”

o573 With M7CL V3 Editor, you can also open files that have been saved on any version of M7CL console or
Editor other than version 3 if the files feature the extension “.M7C” or “.YSE”. However, once you save
these files on the M7CL V3 console or Editor, you will not be able to open them on the other version of

M7CL console or Editor.

.Y 73 If you use the M7CL-48ES console to open a session saved via the M7CL-32/48 console, or if you use the
M7CL-32/48 console to open a session saved via the M7CL-48ES, the patch settings will change and the
same HA settings will be used as follows:

M7CL-32/48 M7CL-48ES
INPUT 1-16 ) | ESIN1-16
INPUT 17-32 ) | ESIN17-32
INPUT 33-48 ) | ESIN 33-48

ST IN 1L-4R «>(*) | OMNI IN 1-8
SLOT1IN 1-16 «>(*) | SLOT1IN 1-16
SLOT2IN 1-16 ) | SLOT2IN 1-16
SLOT3IN 1-16 «>(*) | SLOT3IN 1-16
TALKBACK <> | TALKBACK
OMNI OUT 1-16 <> | ESOUT 1-16

No assignment > ES OUT 17-24
No assignment > OMNI OUT 1-8
SLOT1 OUT 1-16 <> | SLOT10UT 1-16
SLOT2 OUT 1-16 <> | SLOT20UT 1-16
SLOT3 OUT 1-16 <> | SLOT3 OUT 1-16
2TR DIGITAL OUT <> | 2TR DIGITAL OUT

(*) The same HA settings will be used.
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Stage Box Data Conversion

To open the Stage Box Data Conversion dialog box, click the [Stage Box Data Conversion] button in the System Setup
dialog box.

Use this dialog box to convert HA settings and input patch settings accordingly if, for example, you want to use (on an
M7CL-48ES system) data stored by a system that features SB168-ES units connected to M7CL-48 slots.

‘g Stage Box Data Conversion @

Select a combination below between the configurations where
the data cumently loaded was saved, and of the target M7CL.
Then press "Convert" button.

The data saved by The target M7CLis
@— @ | M7CL using Extemal HA via Slot | -> MTCL-48ES
@—— ~) M7CL using BExtemal HA via Slot —» Using Intemal HA
@—— ~1 M7CL using Intemal HA —» Using Bdemal HA via Slot
@—— ©) M7CL-48ES -> Using BExtemal HA via Slot

"MICL48ES —> Using Intemal HA" or
"M7CL using Intemal HA —> M7CL48ES" does not require the conversion.

NOTE:

Data on the local disk is not affected.

Please check WORD CLOCK after loading or synchronizing the data to
the console.

L Comet | l Cancel I

7

— @ @
Analog devices . E - E

3 x SB168-ES 3 x SB168-ES
Internal HA EXT-ES HA
@ o R
M7CL-48 M7CL-48 M7CL-48ES

(With MY16-ES64 and
MY16-EX installed)

(1O M7CL using External HA via Slot —

M7CL-48ES
Converts the patch settings as follows:
INPUT 1-16 () | SLOT1IN1-16 1-8 - ES OUT 17-24
SLOT2 OUT
INPUT 17-32 L= | SLOT2IN1-16 9-16 — | OMNIouUT 1-8
No assignment - SLOT2 OUT 1-16
INPUT 33-48 () | SLOT3IN 1-16
SLOT3 OUT 1-16 — | SLOT30UT 1-16
ST IN 1L-4R () | OMNI'IN 1-8
2TR DIGITAL OUT — | 2TR DIGITAL OUT
SLOT1 IN 1-16 (*) | ESIN1-16
- (*) The same HA settings will be used.
SLOT2 IN 1-16 S0 | ESIN17-32
SLOT3IN 1-16 ) | ESIN 33-48
TALKBACK — | TALKBACK
OMNI OUT 1-16 — | SLOT1 OUT 1-16
SLOT1 OUT 1-16 — | ESOUT1-16
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(@ M7CL using External HA via Slot —

Using Internal HA

Converts the patch settings as follows:

SLOT1 IN 1-16 _06) | INPUT 1-16
SLOT2IN 1-16 ) | INPUT 17-32
SLOT3IN 1-16 () | INPUT 33-48

ST IN 1L-4R () | STIN1L4R
INPUT 1-16 () | SLOT1IN 1-16
INPUT 17-32 () | SLOT2IN1-16
INPUT 33-48 () | SLOT3IN1-16
TALKBACK — | TALKBACK
SLOT1 OUT 1-16 — | OMNI OUT 1-16
OMNI OUT 1-16 — | SLOT10UT 1-16
SLOT2 OUT 1-16 — | SLOT20UT 1-16
SLOT3 OUT 1-16 — | SLOT30UT 1-16
2TR DIGITAL OUT — | 2TR DIGITAL OUT

(*) The same HA settings will be used.

(® M7CL using Internal HA — Using
External HA via Slot

Converts the patch settings as follows:

INPUT 1-16 () | SLOT1IN1-16
INPUT 17-32 () | SLOT2IN 1-16
INPUT 33-48 —(*) | SLOT3IN 1-16
ST IN 1L-4R () | STIN1L4R
SLOT1 IN 1-16 & | INPUT 1-16
SLOT2IN 1-16 0 [ INPUT 17-32
SLOT3IN 1-16 () | INPUT 33-48
TALKBACK — | TALKBACK
OMNI OUT 1-16 — | SLOT10UT 1-16
SLOT1 OUT 1-16 — | OMNI OUT 1-16
SLOT2 OUT 1-16 — | SLOT20UT 1-16
SLOT3 OUT 1-16 — | SLOT30UT 1-16
2TR DIGITAL OUT — | 2TR DIGITAL OUT

(*) The same HA settings will be used.

(49 M7CL-48ES — Using External HA via

Slot

Converts the patch settings as follows:
SLOT1IN 1-16 —(*) | INPUT 1-16
SLOT2IN 1-16 —(*) | INPUT 17-32
SLOT3IN 1-16 —(*) | INPUT 33-48
OMNI IN 1-8 ) | STIN1L4R
ESIN 1-16 ) | SLOT1IN1-16
ES IN 17-32 () | SLOT2IN 1-16
ES IN 33-48 () | SLOT3IN 1-16
TALKBACK — | TALKBACK
SLOT1 OUT 1-16 — | OMNIOUT 1-16
ES OUT 1-16 — | SLOT10UT 1-16
ES OUT 17-24 - 1-8

SLOT2 OUT

OMNI OUT 1-8 - 9-16
SLOT2 OUT 1-16 - No assignment
SLOT3 OUT 1-16 — | SLOT30OUT 1-16
2TR DIGITAL OUT — | 2TR DIGITAL OUT

(*) The same HA settings will be used.

(® [Convert] button

Converts the session using one of the conversion

patterns (1) — (4).
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Undo/Redo Function

In M7CL Editor, you can cancel the latest operation (Undo) and also cancel the cancellation of the latest operation
(Redo). If you perform an Undo operation twice in a row, you can cancel the two most-recent operations. If you per-
form an Undo operation three times in a row, you can cancel the three most-recent operations. In this way, you can
cancel multiple recent operations.

The following table describes how to use the Undo/Redo function.

Undo

Choose [Undo] from the [Edit] menu.

Redo

Choose [Redo] from the [Edit] menu.

Please note, however, that after you perform one of the following operations, you cannot successfully undo or redo
any previous operation:

+ Operations on the M7CL console

+ Quitting Studio Manager

+ Synchronizing with the M7CL console
+ Session operations

‘[.¥ /4 You cannot Undo or Redo the following operations:

e Edits in the Setup window

e Synchronization

» Opening and closing the windows
¢ Resizing or moving the windows
e Stage Box Data Conversion

There are certain other operations that cannot be undone, depending on the function.

For library or scene operations, Undo/Redo applies only to the single most recent operation. You cannot

undo any operations prior to this. Undo/Redo in these windows is available only using the [UNDQ] button
within the respective window. Even if you perform a scene recall from the Master window, you cannot use
a shortcut or menu operation to undo the recall.

10
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Window operations

You can select and open each window from the [Win-

B MicLv:
dows] menu. For the INPUT CH window and Effect Edi- sie gt [UEE Synchronizaion Yiew Help
. Close Ctrl+W
tor window, use the sub-menu to select the channels or Close Al Cue At

Tile Cerl+T
Cascade Ctrl+Ale+T

library you want to see.

Master Cerl+1
Sends On Fader Ctrl+2

Gz CH116 Ctrl+Alt+1

Selected Channel CH17-32 Ctrl+Ale+2

Library CH33-48 Ctrl+Alt+3
Patch Editor STIN Ctrl+Alt+4
Rack MIX Crl+ Alt+5
Meter MATRIX Ctrl+ Alt+6
Group/Link STEREQ/MONO  Ctri+Alt+7
Scene DCA Ctri+Alt+8
User Defined Keys Setup

Output Port

You can choose Tile or Cascade to arrange the windows within the editor.

® Tile ® Cascade

Sz =l E Vs P e |
Fle_ Edt Windows Syndonization View Help Flle Edt Wincows Synchronizaton View Help

Uorary - orary Potch Eator

(o

o.

"
R
R
R
R
R
R
R
R
R
R
R
R
R
R
R

In the Library window or Scene window, click the tabs
located at the top of the window to switch between

pages.
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Synchronizing M7CL Editor

When M7CL Editor starts up, the parameter settings on the console and the parameter settings in M7CL Editor may
be different. Therefore, you must first match the parameter settings on the console with those in M7CL Editor. This
operation is called “synchronization.” Follow the steps below to synchronize M7CL Editor.

1 Select [Synchronize], then [Re-synchronize].

& Re-Synchronize =5
The following window opens. - Santents
. o i 3P @ PO - Oonsole [#] 4 Libraries
2 Select whether you want to transfer your settings to M7CL ' m o
Editor, or vice versa. et
At this time, the All Libs option determines whether or not Scene and [ - | | e ]

Library data is synchronized.

PC = Console: Transfers the current parameter settings in M7CL Editor to your console. On the M7CL-48ES,
the [Stage Box Setup] checkbox will appear. If you want to keep the Stage Box Setup setting of the M7CL-48ES
unit, remove the check from the checkbox.

Console = PC: Transfers the current parameter settings of your console to the M7CL Editor.
3 Click [OK].
A Do not operate the console while synchronization is in progress.

o574 If you use the “Recall” function in Studio Manager, all selected Editors in Studio Manager are synchro-
nized with the corresponding devices.

Offline Edit Function

If you do not want to synchronize your console with M7CL Editor, select [Offline Edit] from the [Synchronization]
menu. To apply your off-line edits to your console, select [Re-Synchronize] from the [Synchronization] with the PC
-> Console option to synchronize the console with M7CL Editor.

The Offline Edit function is also activated when you click the [ONLINE]/[OFFLINE] button in the Master window.

Some effect parameters in the console change their displayed values depending on the sampling fre-
quency. If you switch M7CL Editor from OFFLINE to ONLINE, displayed parameter values may change
because M7CL Editor loads the sampling frequency from the console and updates the display.

Other Functions

[dResetting to the default value (Ctrl(38)+click)

Move the cursor to a control or a parameter value, then hold down the <Ctrl>(<8>) key and click the mouse
button to reset the value to the default (e.g., to reset a pan setting to Center).

However, the channel faders and the send knobs and bar graphs can be set to —ee regardless of the default value.

A Ctrl(38)+Shift+Click

Move the mouse cursor to a channel fader or to a send knob or bar graph, and click while holding down the
<Ctrl>(<38>) key and <Shift> key to set the nominal value regardless of the default value.
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Master window

Master @@

SCENE MEMORY

8ee R
Initial Data E

In the Master window you can synchronize to the M7CL itself, recall scenes, and display the Overview window. To
open this window, choose [Master] from the [Windows] menu.

(JCHANNEL SELECT

This indicates the number and name of the channel to which your operations will apply. To
switch channels, you can either click the [SELECT] button and choose from the list that
appears, or you can click the left/right arrow-shaped channel select buttons. You can also
use the channel name text box to edit the name.

If the Channel Select / Sends On Fader checkbox in the System Setup dialog box is selected,
this parameter is linked with the [SEL] keys on the M7CL console panel.

You can right-click (<control> key + click) the icon to select a different one.

(ASENDS ON FADER

This button indicates whether normal mode or SENDS ON FADER mode is engaged.
Click the button to switch modes. When SENDS ON FADER mode is engaged, the Sends
On Fader window appears. (= p.79)

If the Channel Select / Sends On Fader checkbox in the System Setup dialog box is selected,
this parameter will be linked with the SEND ON FADER mode setting on the M7CL con-
sole.
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ASYNC

This indicates the status of connection and synchronization between M7CL Editor and the M7CL.

(1) [ONLINE]/[OFFLINE] button
® @ The ONLINE/OFFLINE status will alternate each time you click this button.
This has the same function as [Synchronization] menu =>[Offline Edit]. (= p.12)
PG This indicator is shown when M7CL Editor is correctly con-
nected to the M7CL itself. In this state, the parameters of M7LC
Editor and the M7CL itself are linked.

OFFLINE | This indicator is shown when M7CL Editor and the M7CL itself
" are not connected, or when there is a problem with the connec-
tion, or when Offline Edit is selected. In this state, the parame-
ters of M7CL Editor and the M7CL itself are not linked.

@ [RE-SYNC] button
Clicking this button opens the Synchronization dialog box.

This has the same function as [Synchronization] menu => [Re-Synchronize]. (" p.12)

JSCENE MEMORY

Here you can view the currently-recalled scene, and recall or store scenes.

(1 Scene number display
Indicates the number of the scene that is selected for store or recall.

(@ Protect indicator
The lock icon is displayed for scenes that are protected. You will be unable to overwrite
or modify the titles of such scenes. For read-only scenes, “R” appears instead.

(3 Edit indicator

The edit indicator will light when you edit the parameters after recalling a scene.

(4 [STORE] button

This button stores the current scene into the number shown by the scene number dis-

play (D).
5 [A]/[V¥] buttons

These buttons increment or decrement the number shown in the scene number display
(). The scene number display ((1)) will blink until you actually store or recall, and
while blinking will not match the scene number indicated on the M7CL.

(® [RECALL] button

This button recalls the scene of the number shown in the scene number display ((D).
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dNavigation Keys
Opens the corresponding window in the Overview window.
I[:.573 These are not linked with the navigation key section on the panel of the M7CL itself.

1 [17-32] button
Opens the INPUT CH 17-32 window.

@ [1-16] button
Opens the INPUT CH 1-16 window.

3 [ST IN] button
Opens the ST IN window.

® (4 [DCA] button
Opens the DCA window.

(& [STEREO] button
Opens the STEREO/MONO window.

(6 [MIX] button
Opens the MIX window.

@ [MTRX] button
Opens the MATRIX window.

[33-48] button
Opens the INPUT CH 33-48 window. This button is available during offline editing
only if “M7CL-48” or “M7CL-48ES” is selected in the System Setup dialog box. It is also
available during online editing for the M7CL-48 or M7CL-48ES.

®
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Overview window

INPUT CH window

CH 1-16 @.@
(w1 | We | Ws | W: | Ws | We | Wi | We | Wi | W | Wn | e | e | n | Nn_| We |

D OouT D OouT D OouT D OouT

This window displays the mix parameters of INPUT CH 1-16, 17-32, or 33—48(*). The parameters shown in the
window can be selected from the [View] menu or the menu that appears when you right-click (<control> key +
click) in the window.

You can access this window in the following ways.

® From the [Windows] menu, choose [Overview] and select “CH1-16” / “CH17-32” / “CH33-48”(*)
® Use the navigation keys in the Master window to turn on the [1-16] button / [17-32] button / [33-48] button(*)

® On the M7CL itself, assign one of the USER DEFINED KEYS to [1-16]/[17-32]/[33-48]() in [INPUT CH] of [M7CL
EDITOR CONTROL], and execute the function

(*) INPUT CH 33-48 can be viewed during offline editing only if “M7CL-48” or “M7CL-48ES” is selected in the System Setup dialog
box. It can also be viewed during online editing for the M7CL-48 or M7CL-48ES.

(D Input patch

Click here to select the input source that will be assigned to the INPUT CH, from the
following choices.

NONE No assignment

IN1-IN48(*) INPUT jacks 1-48(*)

STIN1L-STIN4R L/R channels of ST IN jacks 1—4
SLOT1-1,SLOT1-2...SLOT3-15, SLOT3-16 | Input channels of an I/O card installed in slots 1-3
RACK1A, RACK1B...RACK8R(B) L/R outputs of Rack 1-8

(*) AD33-48(INPUT jack 33-48) can be viewed during offline editing only if “M7CL-48” or “M7CL-48ES”
is selected in the System Setup dialog box. It can also be viewed during online editing for the M7CL-48
or M7CL-48ES.

@ HA GAIN

Drag the knob in the screen to adjust the gain of the internal head amp or of the exter-
nal head amp (e.g., Yamaha AD8HR, SB168-ES) patched to the INPUT CH.

(3 48V

Switches on/off the phantom power (+48V) of the internal head amp or of the external
head amp (e.g., Yamaha AD8HR, SB168-ES) patched to the INPUT CH.
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(@ @ (Phase)

Inverts the phase of the signal after AD conversion.

(® HPF (High Pass Filter)
Switches the high pass filter on/off. You can drag the numeric value up or down to edit
the cutoff frequency.

® INS (Insert)

Enables/disables the insert-in.

(D D. OUT (Direct out)
Enables/disables the direct output.

EQ (Equalizer)
Switches the EQ on/off. The graph immediately below the button shows the approxi-
mate response of the EQ. Double-click within the graph to open the Selected Channel
window of the corresponding channel. To open the Selected Channel window as an
additional view, hold down the <Ctrl>(<38>) key of your computer keyboard and
double-click the graph.

(@ DYN1/DYN2 (Dynamics 1/Dynamics 2)
Turns the two dynamics processors on/off.
If Gate is assigned (Dynamics 1 only), the status of the gate is shown immediately below

the button.
Gate status e - | E—
indication

On/off status On On On Off
Openiclosed Closed Open Open —
status

Remarks Gain reduction amount |Gain reduction Gain reduction .

is 30 dB or more amount is 0-30 dB |amount is 0 dB

If something other than Gate is assigned, a GR meter is shown immediately below the
button, and the amount of gain reduction is shown while this is on.

The type for each dynamics processor can be selected in the Selected Channel window.
Double-click anywhere other than the DYN1 or DYN2 button to open the Selected
Channel window of the corresponding channel. To open the Selected Channel window
as an additional view, hold down the <Ctrl>(<8>) key of your computer keyboard
and double-click anywhere other than the DYN1 or DYN2 button.

MIX/MATRIX SEND
Switches between the send indications to MIX buses
1-16 and to MATRIX buses 1-8.

The bar graphs located immediately below the button
show the send level of the signals sent from the INPUT
CH to VARI type MIX/MATRIX buses. You can also
drag the bar graph to left or right to set the send level.
While you drag the bar graph, the send level is shown
in the numerical display area for PAN/TO STEREO
MONO ((41).

You can set the minimum value (—eo dB) by holding
down the <Ctr]>(<88>) key of your computer key-
board and clicking the bar graph, or set the nominal  , pre/on (green)

value (0.00 dB) by holding down the <Ctrl>(<88>) ——
key and <Shift> key and clicking the bar graph. « Pre/off (green)
The bar graph display will change according to the [ —

send position (pre/post) and on/off status of the signal e Post/on (yellow)
sent from the INPUT CH to the MIX/MATRIX buses. ——
To switch a send on/off, click the channel number * Post/off (yellow)
located at the left of the bar graph. —
For FIXED-type MIX buses, the bar graph is fixed at nominal level (0 dB),
and only the on/off status is shown.

574 In SENDS ON FADER mode, this button enables you to adjust the send
level using the fader.
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i@ PAN/TO STEREO MONO
The PAN knob adjusts the panning of the signal that is sent from the INPUT CH to the
STEREO bus L/R channels (or the L/C/R channels). You can set this to the center value
by holding down the <Ctrl>(<88>) key of your computer keyboard and clicking this
knob.
The [ST] button is an on/off switch for the signal that is sent from the INPUT CH to
the STEREO bus.
The [M(C)] button is an on/off switch for the signal that is sent from the INPUT CH to
the MONO bus.
If LCR MODE is selected in the Selected Channel window, the [LCR] button will appear
instead of the [ST] button and [M(C)] button, and the [LCR] button will be an on/off
switch for the signal that is sent from the INPUT CH to the LCR bus.

{ SEL (Select)
Selects the INPUT CH for which you want to perform operations. This is linked with
the INPUT section [SEL] keys on the M7CL console panel.

If the Channel Select / Sends On Fader checkbox in the System Setup dia-
log box is not checked, this will not be linked with the M7CL console.

{3 CUE
This button cue-monitors the signal of the INPUT CH. This is linked with the INPUT
section [CUE] keys on the M7CL’s panel.

If the Channel Select / Sends On Fader checkbox in the System Setup dia-
log box is not checked, this will not be linked with the M7CL console.

ON
Switches the INPUT CH or send on/off. In normal mode, this button is linked with the
CH [ON] key in the INPUT section on the M7CL console panel.

The button is color-coded and indicates status as follows:

White: INPUT CH is on (normal mode)

Black: INPUT CH/Send are off.

Other colors: Send is on (SENDS ON FADER mode).
(5 Fader

Adjusts the input level of the INPUT CH, or the send level. In normal mode, this fader
is linked with the fader in the INPUT section on of the M7CL console panel.

The fader is color-coded and indicates status as follows:
White: You can adjust the input level of the INPUT CH (normal mode).
Gray: INPUT CH is off.
Other colors: You can adjust the send level (SENDS ON FADER mode).

The current fader value is shown in the numerical box located immediately below the
fader.

You can set this to the minimum value (e dB) by holding down the <Ctrl>(<38>) key
of your computer keyboard and clicking the fader knob, or set it to the nominal value
(0.00 dB) by holding down the <Ctrl>(<88>) key and <Shift> key and clicking the
fader knob.
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The numbers and alphabetical let-
ters at the right of the fader indicate
the DCA group and mute groups to
which that channel belongs, and
show the Recall Safe and Mute Safe
status of the channel.

The numbers of DCA groups
to which this channel belongs
are shown in yellow.

The numbers of mute groups to
which this channel belongs are
shown in red.

If this channel is set to
Recall Safe, the R character
is shown in green.

If this channel is set to Mute
Safe, the M character is
shown in green.

Channel number
This is the number of the INPUT CH. You can open the Selected Channel window for
this channel by double-clicking this number. If you hold down the <Ctrl>(<88>) key of

your computer keyboard and double-click this, the Selected Channel window will open
as an additional view.

(@ Channel name

This is a text box that displays the channel name. You can also edit the channel name in
this text box.

19 M?7CL V3 Editor Owner’s Manual



ST IN window ( M7CL-32/M7CL-48 only)

ST =ax)

ETINIL STINIR STINZL STIHZR STINSL STINZR STINUL STIHUR

Om@=md® 9 0 0 979
[ ==
-2 dE 2de -22de -1 de

In this window you can view and edit the mix parameters of ST IN channels 1-4. The parameters shown in the win-
dow can be selected from the [View] menu or the menu that appears when you right-click (<control> key + click) in
the window.

You can access this window in the following ways.
® From the [Windows] menu, choose [Overview] and then choose “ST IN”
® Use the navigation keys in the Master window to turn on the [ST IN] button

STNIL | STINIR
48y o el (O INPUT PATCH
HE- Selects the input source that will be assigned to the ST IN channel. The input sources
T that can be assigned are the same as for an INPUT CH (= p.16).
@ HA GAIN

Drag the knob in the screen to adjust the gain of the internal head amp or of the exter-
nal head amp (e.g., Yamaha AD8HR, SB168-ES) patched to the ST IN channel.

348V
Switches on/off the phantom power (+48V) of the internal head amp or of the external
head amp (e.g., Yamaha AD8HR, SB168-ES) patched to the ST IN channel.

(» @ (Phase)

Inverts the phase of the signal after AD conversion.

(& HPF (High Pass Filter)
Switches the high pass filter on/off. You can drag the numeric value up or down to edit
the cutoff frequency.

(® EQ (Equalizer)
Switches the EQ on/off (the L/R settings are linked). This is the same as the equalizer for
INPUT CH (= p.17).
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_ (D DYN1/DYN2 (Dynamics 1//Dynamics 2)

These buttons switch the two dynamics processors on/off. This is the same as the

B o marmax seno
M

Switches between the send indications to MIX buses 1-16 or to MATRIX buses 1-8.
This is the same as the mix/matrix send for INPUT CH (= p.17).

(© BALANCE
The BALANCE knob adjusts the balance of the signal that is sent from the ST IN chan-
nel to the STEREO bus L/R channels (or the L/C/R channels). Other than the BAL-
ANCE knob, this is the same as PAN/TO STEREO MONO for an INPUT channel

(= p.18).
SEL (Select)

Selects the ST IN channel for which you want to perform operations. (L and R can be

© selected separately.) This is linked with the ST IN section [SEL] keys on the M7CL’s
panel.
© If the Channel Select / Sends On Fader checkbox in the System Setup dia-
C log box is not checked, this will not be linked with the M7CL console.
: 1) CUE
® §= This button cue-monitors the signal of the ST IN channel (L/R are linked). This is
- linked with the ST IN section [CUE] keys on the M7CL's panel.

If the Channel Select / Sends On Fader checkbox in the System Setup dia-
log box is not checked, this will not be linked with the M7CL console.

12 ON
Switches the ST IN channel on/off (the L/R settings are linked). This is linked with the
ST IN section CH [ON] keys on the M7CL’s panel.
The button is color-coded and indicates status as follows:
White: ST IN channel is on (normal mode)
Black: ST IN channel/Send are off.
Other colors: Send is on (SENDS ON FADER mode).

i3 Fader
Adjusts the input level of the ST IN channel. When the M7CL itself is in other than
SENDS ON FADER mode, this is linked with the INPUT section faders of the M7CL’s

panel.

The fader is color-coded and indicates status as follows:
White: You can adjust the input level of the ST IN channel (normal mode).
Gray: ST IN channel is off.

Other colors: You can adjust the send level (SENDS ON FADER mode).

The current fader value is shown in the numerical box located immediately below the
fader. This is the same as the fader for INPUT CH (‘= p.18).

Channel number
This is the number of the ST IN channel. You can double-click this number to open the
Selected Channel window for this channel. If you hold down the <Ctrl>(<38>) key of
your computer keyboard and double-click this, the Selected Channel window will open
as an additional view.

(5 Channel name
This is a text box that displays the channel name. You can also edit the channel name in

this text box.
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MIX window
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In this window you can view and edit the parameters of MIX channels 1-16. The parameters shown in the window

can be selected from the [View] menu or the menu that appears when you right-click (<control> key + click) in the
window.

You can access this window in the following ways.

® From the [Windows] menu, choose [Overview] and then choose “MIX”
® Use the navigation keys in the Master window to turn on the [MIX] button

(1) OUTPUT PATCH

Click here to select the output port that will be assigned to the MIX channel, from the
following choices.

O

ES 1-ES24(M7CL-48ES) EtherSound output channels 1-24

OMNI1-OMNI8 OMNI OUT jacks 1-8

OMNI9-OMNI16(M7CL-32/48) OMNI OUT jacks 9-16

SLOT1-1,

SLOT4-2...SLOT3-16 Input channels of an I/O card installed in slot 1-3

RACKI1A,

RACK1B...RACK8R(B) L/R outputs of Rack 1-8

2TROUT L, 2TROUT R

L/R channels of the 2TR OUT DIGITAL jack

If multiple patches have been made, only the first port is shown.

If you change the patching in this window, the port that had been assigned until then
will be cancelled, and only the newly selected port will be assigned.

@ EQ (Equalizer)
Switches the EQ on/off. This is the same as the equalizer for INPUT CH (= p.17).
(® DYN1(Dynamics 1)

Switches the dynamics processor on/off. This is the same as the dynamics 2 for INPUT
CH (= p.17).

@ INS (Insert)

Enables/disables the insert-in.
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I ST

Center

(5 MATRIX SEND
These bar graphs indicate the send levels of the signals sent from the MIX  « prefon (green))
channel to MATRIX 1-8 bus. You can also adjust the send levels by drag-
ging a bar graph to left or right. While you drag the bar graph, the send  « Pre/off (green)
level is shown in the numerical display area for TO STEREO/MONO.

i 1 |
You can set the minimum value (—ee dB) by holding down the * Post/on (yellow)
<Ctrl>(<38>) key of your computer keyboard and clicking the bar ——
graph, or set the nominal value (0.00 dB) by holding down the * Post/off (yellow)
[

<Ctrl>(<38>) key and <Shift> key and clicking the bar graph.
The bar graph display will change as follows according to the send position (pre/post)
and on/off status of the signal sent from the MIX channel to the MATRIX buses.

To switch a send on/off, click the channel number located at the left of the bar graph.

(® PAN/BALANCE
The PAN knob adjusts the panning of the signal that is sent from the mix channel to the
STEREO bus L/R channels (or the L/C/R channels). You can set this to the center value
by holding down the <Ctrl>(<38>) key of your computer keyboard and clicking this
knob. If assigned as a stereo bus, this adjusts the balance of the odd-numbered channel
and even-numbered channel. The stereo bus setting can be made in Mix Bus Setup of
the Mixer Setup dialogbox.
The [ST] button is an on/off switch for the signal that is sent from the mix channel to
the STEREO bus.
The [MONO] button is an on/off switch for the signal that is sent from the mix channel
to the MONO bus.
If LCR MODE is selected in the Selected Channel window, the [LCR] button will
appear instead of the [ST] button and [MONO] button, and the [LCR] button will be
an on/off switch for the signal that is sent from the mix channel to the LCR bus.

(@D VARI/FIXED
Indicates the type (VARI or FIXED) of the currently selected MIX bus. This parameter
can be switched in Mix Bus Setup of the Mixer Setup dialogbox.

SEL (Select)

Selects the MIX channel for which you want to make settings.

(® CUE
This button cue-monitors the signal of the MIX channel.

ON
Switches the MIX channel on/off.
The button is color-coded and indicates status as follows:

White: MIX channel is on (normal mode).

Black: MIX channel/Send is off.

Other colors: Send is on (SENDS ON FADER mode).
i) Fader

Adjusts the output level of the MIX
channel. The current fader value is
shown in the numeric box immediately
below the fader. You can set this to the
minimum value (—e dB) by holding
down the <Ctrl>(<88>) key of your
computer keyboard and clicking the
fader knob, or set it to the nominal value
(0.00 dB) by holding down the
<Ctrl>(<38>) key and <Shift> key and
clicking the fader knob.

The numbers and alphabetical letters at
the right of the fader indicate the mute
groups to which that channel belongs, and show the Recall Safe and Mute Safe status of
the channel.

The numbers of mute groups
to which this channel belongs
are shown in red.

If this channel is set to Recall
Safe, the R character is
shown in green.

If this channel is set to Mute
Safe, the M character is
shown in green.

The fader is color-coded and indicates status as follows:
White: You can adjust the input level of the MIX channel (normal mode).
Gray: MIX channel is off.
Other colors: You can adjust the send level (SENDS ON FADER mode).
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(2 Channel number
Indicates the number of the MIX channel. You can double-click this number to open the
Selected Channel window for this channel. If you hold down the <Ctrl>(<38>) key of your
computer keyboard and double-click this, the Selected Channel window will open as an addi-
tional view.

(3 Channel name
This is a text box that displays the channel name. You can also edit the channel name in
this text box.

MATRIX window

In this window you can view and edit the parameters of MATRIX channels 1-8. The parameters shown in the win-
dow can be selected from the [View] menu or the menu that appears when you right-click (<control> key + click) in
the window.

You can access this window in the following ways.

® From the [Windows] menu, choose [Overview] and then choose “MATRIX”
® Use the navigation keys in the Master window to turn on the [MTRX] button
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STEREQ

OMIX/CH/ST IN (Send levels from the MIX/INPUT CH/ST IN to
the MATRIX bus)
This switches between indicating the sends from MIX channels 1-16, the sends from
INPUT CH 1-16/ 17-32 / 33—-48 (*), and the sends from ST IN.

The bar graphs located immediately below the button indicate/adjust the level of the

signal that is sent from each channel to the MATRIX bus. The method of operation and

the meaning of the display are the same as for ((5)) MATRIX in the MIX window

(= p.23).

(*) INPUT CH 33-48 can be viewed during offline editing only if “M7CL-48” or “M7CL-48ES” is selected in
the System Setup dialog box. It can also be viewed during online editing for the M7CL-48 or M7CL-48ES.

@) STEREO (Send levels from the STEREO channels to the MATRIX

bus)

Here you can view and edit the send levels of the signals sent from the STEREO chan-
nels to the MATRIX bus. While you drag the bar graph, the send level is shown in the
numerical display area immediately below. The method of operation and the meaning
of the display are the same as for ((5)) MATRIX in the MIX window (= p.23).

® EQ (Equalizer)
Switches the EQ on/off. The graph immediately below the button shows the approxi-
mate response of the EQ. This is the same as the equalizer for INPUT CH (w p.17).

(4 DYN1(Dynamics 1)
Switches the dynamics processor on/off. This is the same as the dynamics 2 for INPUT
CH (= p.17).

B INS (Insert)

Enables/disables the insert-in.

(® SEL (Select)
Selects the MATRIX channel for which you want to make settings.

(D CUE
This button cue-monitors the signal of the MATRIX channel.

ON
This switches the MATRIX channel on/off.

If the corresponding channel is off, the fader will be grayed out.

(@ Fader
This adjusts the output level of the MATRIX channel. The current fader value is shown
in the numeric box immediately below the fader.
The numbers and alphabetical letters at the right of the fader indicate the mute groups
to which that channel belongs, and show the Recall Safe and Mute Safe status of the
channel. (For the significance of the numbers and alphabetical letters, see = p.18).

Channel number
Indicates the number of the MATRIX channel. You can double-click this number to
open the Selected Channel window for this channel. If you hold down the
<Ctrl>(<88>) key of your computer keyboard and double-click this, the Selected
Channel window will open as an additional view.
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STEREO/MONO window

ST/MONC

Center -17.8A4E

B

MOND

In this window you can view and edit the parameters of the STEREO and MONO channels. The parameters shown
in the window can be selected from the [View] menu or the menu that appears when you right-click (<control> key
+ click) in the window.

You can access this window in the following ways.
® From the [Windows] menu, choose [Overview] and then choose “STEREO/MONO”
® Use the navigation keys in the Master window to turn on the [STEREO] button

(D EQ (Equalizer)
Switches the EQ on/off (the L/R settings are linked). This is the same as the equalizer for

T INPUT CH (= p.17).

m (@ DYN1(Dynamics 1)

@7= Switches the dynamics processor on/off. This is the same as the dynamics 2 for INPUT
MATRIX

CH (= p.17).

(® INS (Insert)
Enables/disables the insert-in. (The L/R settings are linked.)

(4 MATRIX SEND
Here you can view and edit the send levels of the signals sent from the STEREO/MONO
channel to MATRIX 1-8 bus. The method of operation and the meaning of the display
are the same as for MATRIX in the MIX window (= p.23).

SEL
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(5 BALANCE
Adjusts the left/right balance of the STEREO channel.

For MONO channels, this control indicates the send level to the MATRIX bus.
(® SEL (Select)

Selects the channel for which you want to make settings. (You can specify L and R inde-
pendently.) This is linked with the STEREO/MONO MASTER section [SEL] keys on
the M7CL’s panel.

(@D CUE
This button cue-monitors the signal of the STEREO/MONO channel. This is linked
with the STEREO/MONO MASTER section [CUE] keys on the M7CL’s panel.

ON
This switches the STEREO/MONO channel on/off. This is linked with the STEREO/
MONO MASTER section [ON] keys on the M7CL’s panel.

The button is color-coded and indicates status as follows:

w o
|

White: STEREO/MONO channel is on (normal mode).
Black: STEREO/MONO channel/Send is off.
Other colors: Send is on (SENDS ON FADER mode).

(@ Fader

Adjusts the output level of the STEREO/MONO channel. This is linked with the STE-
REO/MONO MASTER section faders of the M7CL's panel.

The current fader value is shown in the numeric box immediately below the fader.

The numbers and alphabetical letters at the right of the fader indicate the mute groups
to which that channel belongs, and show the Recall Safe and Mute Safe status of the
channel. (For the significance of the numbers and alphabetical letters, see = p.21).

The fader is color-coded and indicates status as follows:

White: You can adjust the input level of the STEREO/MONO channel (nor-
mal mode).
Gray: STEREO/MONO channel is off.

Other colors: You can adjust the send level (SENDS ON FADER mode).
Channel number

This is the channel number (ST or M). You can double-click this number to open the
Selected Channel window for this channel. If you hold down the <Ctrl>(<88>) key of
your computer keyboard and double-click this, the Selected Channel window will open
as an additional view.
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DCA window

H.AAdE dE A AR -E.EAdE A.A8dE -E.EAdE E.168dE
DCA1 DCAZ OCAY DCAT OCAE DCAT

In this window you can view and edit the parameters of DCA groups 1-8.

You can access this window in the following ways.
® From the [Windows] menu, choose [Overview] and then choose “DCA”
® Use the navigation keys in the Master window to turn on the [DCA] button

(@) CUE

This button cue-monitors all channels that are assigned to the DCA group.

@ ON
If you turn this on, all channels assigned to the DCA group will be turned on. If you
turn this off, no signal will be output from the channels assigned to the DCA group.

If this button is off, the fader will be grayed out.

(3 DCA fader
This fader adjusts the level of the DCA group.
The current fader value is shown in the numeric box immediately below the fader.
You can set this to the minimum value (—e dB) by holding down the <Ctrl>(<38>) key
of your computer keyboard and clicking the fader knob, or set it to the nominal value
(0.00 dB) by holding down the <Ctrl>(<88>) key and <Shift> key and clicking the
fader knob. If the fader is at nominal level, the green indicator at the right of the fader
will light.
If a DCA group is set to Recall Safe, the R character at the lower right of the fader is dis-
played in green.

(® DCA number
This is the number of the DCA group.

(5) DCA group name
This is a text box that displays the DCA group name. You can also edit the DCA group

name in this text box.
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Selected Channel window

Here you can set the parameters of the currently selected input channel (INPUT CH 1-48(*), ST IN channels 1-4) or
output channel (MIX channels 1-16, MATRIX channels 1-8, STEREO/MONO channels).

You can access this window in the following ways.
@ From the [Windows] menu, choose [Selected Channel] and select “MAIN VIEW”
® Double-click the channel number, EQ, DYN1, or DYN2 button in one of the Overview windows.
@ On the M7CL itself, assign one of the USER DEFINED KEYS to [1-16]/[17-32]/[33-48] (*) in [SEL CH] of [M7CL EDI-
TOR CONTROL], and execute the function

By choosing [Selected Channel] from the [Windows] menu and then selecting “ADDITIONAL VIEW,” you
can view a window for a channel that is not selected. This ADDITIONAL VIEW is not linked with [SEL] key
operations on the panel of the M7CL.

The type of parameters that can be edited in this window depends on the type of the currently selected channel. The
parameters of the Selected Channel window are explained below, in the order of input channels (input channels 1-
48, ST IN channels 1-4), MIX channels, MATRIX channels, and STEREO/MONO channels.

() INPUT CH 33-48 can be viewed during offline editing only if “M7CL-48” or “M7CL-48ES” is selected in the System Setup dialog box.
It can also be viewed during online editing for the M7CL-48 or M7CL-48ES.

If an input channel is selected

® INPUT CH window

Selected Channel ==

CHANNEL —MM——— - DYNAMICS 1 TWVFE

-22dp

TO STEREC/MONO

MODE

FILTER
SOURCE
SELF FOST EQ

DYNAMICS 2 TWPE
i

KEY IN

SOURCE
SELF FOST ER

7 INSERT
3. HIGH-MID— ouT L] FONT

678 OPMNIL 1 OPMNIL 1 FRE EQ

L iia @ o

ziowmo— ¢

-BdB
DIRECT QUT E

PONT

- 3 FRE HFF

B.a6dE
ATT— [ = RECALL SAFE SAFE
8006 MUTE SAFE

.78
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® ST IN channel window

Selected Channel @@

CHAMMEL —MMM—— HA = DYNAMICS 1 TVPE GATE

o5 N out
asv 5 iR
! 20 %

OMKI 1 -EdB

< STINIL
Rt1L

TO STEREQ/MOMNO

MONF

ST/MOMNO

BALANGE ELTER
SOURGE -

SELF FOST EQ 8 BHz

DYNAMICS 2 TVPE

o FREQU
SOURCE
-

7.18icHe
2 menmo— ¢ -~ DCA MUTE
878 11.8kHz  -16.6dB
zrowmn— ¢ 4 N
8.7 9%BHz  +13.84E
- |
125Hz = +A5d6

ATT—— RECALL SAFE
8028 MUTE SAFE

I.573 Unless otherwise specified, the parameters explained below are common to INPUT CH 1-48 and ST IN
channels 1-4.

(ACHANNEL SELECT (Channel selection)

(1) SELECT (Channel selection)
Indicates the number and name of the channel you are editing. To switch channels, use the SELECT button or the
triangle buttons at left and right. The channel selected in the Main View is linked with the [SEL] keys in the
INPUT section of the M7CL’s panel. You can right-click (<control> key + click) the icon and select the desired
choice. You can also edit the channel name in the text box.

(@ LIBRARY
Accesses the Input Channel Library. Click this button to open the INPUT CH page of the Library window.

(® INPUT PATCH

Selects the input source assigned to the input channel (for the selectable input sources, = p.16).
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ATO MIX/TO MATRIX SEND

O MIX/MATRIX send level
This adjusts the send level of the signal sent from the input channel to VARI-type MIX bus and MATRIX bus. The
current value is shown in the numerical box immediately below.

@ PRE (PRE/POST)
This selects PRE or POST as the point from which the signal is sent from the input channel to the MIX bus and
MATRIX bus. The point will be PRE POINT when this is on, and POST FADER when this is off. The PRE POINT
setting can be specified in the Mixer Setup dialogbox.

573 Right-click the PRE button to display a context-sensitive menu that will enable you to specify ALL PRE,
ALL POST, or other options.

(3® ON (MIX/MATRIX send on/off)
This is an on/off switch for the signal sent from the input channel to the MIX bus and MATRIX bus.

e If MIX buses or MATRIX buses are being used in stereo, the Knob of odd-num-
odd-numbered knob will be PAN. bered side Knob of odd-
numbered

side

e If the FIXED type is selected for the MIX bus, only the ON but-

» The stereo/mono setting and the VARI type / FIXED type setting can be made in the Mixer Setup dialogbox.

(@ Channel name
This section indicates the name of the MIX channel or MATRIX channel.

JHA GAIN/9G/HPF

+18dE

O HA (HA Gain)
Adjusts the gain of the internal head amp or of the external head amp (e.g., Yamaha AD8HR, SB168-ES) patched
to the input channel. The current value is shown in the numerical box below the knob. You can set this to the
default value (+10 dB) by holding down the <Ctrl>(<88>) key and clicking the knob. You can also use the [48V]
button to switch phantom power on/off.

@ @ (Phase)

Inverts the phase of the signal after AD conversion.
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(® HPF (High Pass Filter)

Use the [ON] button at the right to switch the high-pass filter on/off. You can use the knob at left to adjust the

cutoff frequency. The current value is shown in the numerical box below the knob. An indication of “H” will
appear on the EQ graph of the equalizer.

(ATO STEREO/MONO

Here you can specify how the signal will be sent from the input channel to the STEREO bus / MONO bus.
MODE

e ST/MONO button

When this button is on, the signal will be sent to the STEREO L/R bus and independently to the MONO bus.
TO STEREO/MONO —————— TO STEREQ/MONO

MODE MODE

ST/MONO ST/MONO

BALANCE

| 81 | st

Center Center

[INPUT CH 1-48] [ST IN channel 1-4]

Adjusts the panning of the signal sent from the input channel to the STEREO bus L/R chan-

nels. You can set this to the center position by holding down the <Ctrl>(<38>) key of the
PAN (BALANCE for STIN) computer keyboard and clicking the knob. This is linked with the [PAN] encoder in the
SELECTED CHANNEL section of the M7CL panel.

ST Switches the signal sent from the input channel to the STEREO bus on/off.

M(C) Switches the signal sent from the input channel to the MONO bus on/off.

¢ LCR button

When this button is on, the signal will be sent to the L/C/R buses which work in conjunction with each other.

TO STEREQ/MONOQ —— TO STEREQ/MONQ ——

MODE MODE
LCR LCR

BALANCE

Centear Canter

[INPUT CH 1-48] [ST IN channel 1-4]

Adjusts the panning of the signal that is sent from the input channel to each of the L/C/R

channels. You can set this to the center position by holding down the <Ctrl>(<38>) key of
PAN (BALANCE for STIN) the computer keyboard and clicking the knob. This is linked with the [PAN] encoder in the
SELECTED CHANNEL section of the M7CL panel.

CSR (Center Side Ratio) f;c:‘:;ztzftr(l)e 1p(;gtp:/ortlon of the CENTER channel level relative to the STEREO bus L/R in a
— 0.
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(JEQUALIZER

10k 20k

(4) @ FREOUENCY GRIN (6)

4. HIGH -,

3. HIGH-MID— l —

12.5kHz

1.1 I A8kHz

2, LOW-MID— / {

6.8 - 1.68kHz

/i <

A.7H

© a
A.AdE
(1O LIBRARY
Accesses the INPUT EQ page of the LIBRARY window.
2@ ON
Switches the EQ on/off.
(® EQ graph

Indicates the response for the EQ of the currently selected channel. To reset the EQ to flat response, hold down
the <Ctrl>(<88>) key of your computer keyboard and click the graph (The HPF setting will remain).

@Q
&) FREQUENCY

(® GAIN
These knobs adjust the Q, center frequency, and boost/cut amount for the four bands LOW, LO-MID, HI-MID,
and HIGH.

@[] HIGH shelving
If this button is on, the HIGH EQ will be switched to a shelving type (the Q knob of the HIGH EQ will disap-
pear).

LPF (Low Pass Filter)

If this button is on, the HIGH EQ will function as a low pass filter. The Q knob of the HIGH EQ will disappear,
and the GAIN knob will act as the low pass filter on/off switch.

@[] LOW shelving
If this button is on, the LOW EQ will be switched to a shelving type (the Q knob of the LOW EQ will disappear).

@ TYPE 1/TYPE 1l (EQ type)

Selects either TYPE I (the algorithm used by previous digital mixers) or TYPE II (a newly developed algorithm) as
the EQ type.
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i) ATT (Attenuation)

Adjusts the amount of attenuation/gain.

JIDYNAMICS1/2

You can select one of the following types for each of the two dynamics processors.

DYNAMICS1: GATE, DUCKING, EXPANDER, COMPRESSOR
DYNAMICS2: COMPRESSOR, COMPANDER-H, COMPANDER-S, DE-ESSER

If GATE/DUCKING is selected

® @
DYMAMICS 1 TVFE GATE —
IN o I_IEF::I uT ,
-k
-12 -2BdE 3l ms
-1 TRESHOLD RAMGE  DECAY
-2d
!
L - I R & ATTACK
KEY IN
FILTER
SOURCE
SELF FOST ER S—
FREE&.
),
O TYPE
Indicates the type of the currently selected gate. You can click here to select the type.
@ LIBRARY

This button accesses the dynamics library. Clicking this button will open the DYNAMICS page of the LIBRARY
window.

®ON
This button switches the gate on/off.

(9 Response curve
Indicates the response for the gate of the currently selected channel.

(3 GR meter

This meter indicates the amount of gain reduction.

(® THRESHOLD (Threshold level)

Specifies the level at which the gate will open and close. The gate will open when the key-in signal exceeds this
level, and will close when the signal falls below this level.

@ RANGE

Specifies the amount by which the signal is attenuated while the gate is closed.

DECAY
Specifies the time over which the gate will close after the hold time has elapsed.

@ ATTACK

Specifies the time from when the key-in signal exceeds the threshold level until the gate opens.
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HOLD
Specifies the time that the gate will remain open after the key-in signal falls below the threshold.

() KEY IN SOURCE

Click this to select one of the following signals to use as the key-in source.

SELF PRE EQ The pre-EQ signal of the currently selected input channel

SELF POST EQ The post-EQ signal of the currently selected input channel

MIX OUT 13-16 The out;_)ut signal of the corresponding MIX channel immediately before the output
attenuation

CH 1-48 POST EQ The post-EQ signal of the corresponding input channel (however, you can only choose

STIN1L-STIN4R POST EQ channels belonging to the same group, within the seven groups CH1-8, CH9-16,
CH17-24, CH25-32, CH33-40, CH41-48, and STIN1L-STIN4R).

{© CUE
This button cue-monitors the currently selected key-in signal. This is not shown in the ADDITIONAL VIEW.

(9 KEY IN FILTER
Select the type of filter applied to the selected key-in signal; HPF (high pass filter), BPF (band pass filter), or LPF
(low pass filter). The ON/OFF button switches the filter on/off.

If you’ve selected BPF, use the two knobs to adjust the band pass frequency and Q. If you've selected HPF or LPE,
use the knob to adjust the cutoff frequency.

If COMPRESSOR is selected

® O

DYMNAMICS 2 TvPE COMPF
IN

RATIO  KNEE
-k !
A.AdE
-0 -di -0 0 +#
KEY IMN
SOURCE
SELF FOST ER
OTYPE
Indicates the type of the currently selected compressor. You can click here to select the type.
(@ LIBRARY

This button accesses the dynamics library. Clicking this button will open the DYNAMICS page of the LIBRARY
window.

®ON

This button switches the compressor on/off.

(9 Response curve
Indicates the response for the compressor of the currently selected channel.

(3 GR meter

This meter indicates the amount of gain reduction produced by the compressor.

(® THRESHOLD

Specifies the threshold level at which the compressor will operate. The input signal will start being compressed
when the key-in signal exceeds this level; compression will be removed when the signal falls below this level.
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@ RATIO

Specifies the ratio at which the input signal will be compressed when the key-in signal exceeds the threshold.

KNEE

Specifies the sharpness at which the output level will change. You can select from HARD or 1-5.
(© ATTACK

Specifies the time from when the key-in signal exceeds the threshold level until the signal starts being compressed.

GAIN

Adjusts the gain of the signal after it has passed through the compressor.
() RELEASE

Specifies the time from when the key-in signal falls below the threshold level until compression is removed.

(@ KEY IN SOURCE
Click this to select the key-in signal that you want to use.

The choices are the same as for GATE.

If COMPANDER-H, COMPANDER-S is selected
® @

i

DYMNAMICS 2 TYFPE COMPAMDER-H

IN_ U
IUER
cE | | -— {

- s
-1z -18dE ~ 35:1 EdE
-1% TRESHOLD RATIO  WIOTH
-2d
——
/ \
-&0
2 Tms 2ea9ns A.AdE
—G0 -d0 -20 0 HE ATTACK RELERSE  GHIN
KEY IM
SOURCE
SELF FOST ER
O TYPE
Indicates the type of the currently selected compressor. You can click here to select the type.
(@ LIBRARY

This button accesses the dynamics library. Clicking this button will open the DYNAMICS page of the LIBRARY
window.

®ON

This button switches the compressor on/off.

(9 Response curve
Indicates the response for the compander of the currently selected channel.

(5) GR meter

This meter indicates the amount of gain reduction produced by the compressor.

(® THRESHOLD

Specifies the threshold level at which the compressor will operate. The input signal will start being compressed
when the key-in signal exceeds this level; compression will be removed when the signal falls below this level.

@ RATIO

Specifies the ratio at which the input signal will be compressed when the key-in signal exceeds the threshold.
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WIDTH
Specifies the width between the threshold level of the compressor (THRESHOLD) and the threshold level of the
expander. The expander effect will apply to levels below THRESHOLD + WIDTH.

@ ATTACK

Specifies the time from when the key-in signal exceeds the threshold level until the signal starts being compressed.

GAIN

Adjusts the gain of the signal after it has passed through the compressor.
() RELEASE

Specifies the time from when the key-in signal falls below the threshold level until compression is removed.

@ KEY IN SOURCE
Click this to select the key-in signal that you want to use.

The choices are the same as for GATE.

If DE-ESSER is selected

DE-ESSER

I ouT
QUER

-k

-12 -51de  2.58kH=z
-13 TRESHOLD FREQ.

-24

=G0 =d0 =20 0 +13
KEY IM
SOURCE
SELF FOST ER
O TYPE
This indicates that De-Esser is the currently selected type.
(@ LIBRARY

This button accesses the dynamics library. Clicking this button will open the DYNAMICS page of the LIBRARY
window.

®ON

This button switches the de-esser on/off.

(9 Response curve
Indicates the response for the de-esser of the currently selected channel.

(3 GR meter

This meter indicates the amount of gain reduction produced by the de-esser.

(® THRESHOLD

Specifies the threshold level at which the de-esser will operate. The input signal will start being compressed when
the key-in signal exceeds this level; compression will be removed when the signal falls below this level.

(D FREQ. (Minimum frequency)

Specifies the minimum frequency at which the key-in signal will activate the de-esser.

KEY IN SOURCE
Click this to select the key-in signal that you want to use.

The choices are the same as for GATE.
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(JINSERT (except for ST IN channels)

INSERT
T N FOINT
OMHI 1 OMHI 1 PRE EQ

|—HA

(DON

Enables/disables insert-in/out.

(@ OUT (Insert out)

Click this to select the output port that will be assigned to insert-out, from the following choices.

NONE No assignment

OMNI 1-OMNI 8(M7CL-48ES) OMNI OUT jacks 1-8

SLOT1-1, SLOT1-2...SLOT3-15, SLOT3-16 Output channels of an 1/O card installed in slots 1-3
RACK1A, RACK1B...RACK8R(B) L/R outputs of Rack 1-8

@ IN (Insert in)

Click this to select the input port that will be assigned to insert-in, from the following choices.

NONE No assignment

OMNI 1-OMNI 8(M7CL-48ES) OMNI IN jacks 1-8

SLOT1-1, SLOT1-2...SLOT3-15, SLOT3-16 Input channels of an 1/O card installed in slots 1-3
RACK1A, RACK1B...RACK8R(B) L/R inputs of Rack 1-8

(© POINT (Insert point)
Selects the position at which insert-in/out will be patched. Choose from PRE EQ, PRE FADER, or POST ON.

(® HA gain (M7CL-48ES)
Adjusts the HA gain for OMNI IN. This knob appears only if you select OMNI as INSERT IN ((3)).

(6 48V (M7CL-48ES)
Switches phantom power (+48V) on/off. This button appears only if you select OMNI as INSERT IN ((3)).

(ADIRECT OUT (except for ST IN channels)

L

FOINT
— HOME FRE HFF

DIRECT OUT

A.AAdE

(DOON

Turns the direct output on/off.

(@ DIRECT OUT GAIN

Adjusts the gain of the direct output. The current value is shown in the numerical box below the knob. You can set
this to the nominal value (0.0 dB) by holding down the <Ctrl>(<88>) key and clicking the knob.
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(® DIRECT OUT PORT

Click this to select one of the following output ports as the one used for direct out.

NONE No assignment

OMNI 1-8 OMNI OUT jacks 1-8

OMNI 9-16(M7CL-32/48) OMNI OUT jacks 9—-16
SLOT1-1,SLOT1-2...SLOT3-16 Output channels of an I/O card installed in slots 1-3

(4 DIRECT OUT POINT
Selects the position at which direct out will be patched. Choose from PRE HPF, PRE EQ, PRE FADER, or POST
ON.

JRECALL SAFE/MUTE SAFE

These enable/disable Recall Safe and Mute Safe for the channel.

RECALL SAFE

MUTE SAFE

ADCA GROUP/MUTE GROUP

1) DCA GROUP
Selects the DCA group (1-8) to which that channel belongs.

e IS OMUTE GROUP
| | Selects the mute group (1-8) to which that channel belongs.

1 ON
Switches the input channel on/off. This is linked with the INPUT section CH [ON] keys
on the M7CL’s panel.

If the corresponding channel is off, the fader will be grayed out.

(@ Fader
Adjusts the input level of the input channel. This is linked with the INPUT section fad-
ers of the M7CL’s panel. A meter indicating the signal level is shown at the right of the
fader, and the current value is shown in the numerical box immediately below. You can
set this to the minimum value (—ee dB) by holding down the <Ctrl>(<8>) key of your
computer keyboard and clicking the fader knob, or set it to the nominal value (0.00 dB)
by holding down the <Ctrl>(<88>) key and <Shift> key and clicking the fader knob.

(3 CUE

This button cue-monitors the signal of the input channel. This is linked with the
INPUT section [CUE] keys on the M7CL’s panel.
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If a MIX channel is selected

Selected Channel El@

CHANNEL ——— DYNAMICS 1 TVPE

TO STEREQ/MONO

MGDE

TO MATRIX
, « EB

-2 6548 SOUR
SELF FRE EQ

Q FREQUENCY A

p» @

L] 14 HkHz 3 AdB
7 INSERT
F. HIGH-MID— ouT L} POMNT
a7 HONE OMHI 1 PRE FADER

zowmo— ¢ HAO
-EdE

670 | 190kHo  9.AdE
|

12 EAEHz  -10.8dE

- —

ATT— (= RECALL SAFE
B AR MUTE SAFE

(ACHANNEL SELECT (Channel selection)

(1) SELECT (Channel selection)
Except for the fact that your editing applies to a MIX channel, this is
the same as the channel selection for an input channel (' p.30).

(@ LIBRARY

T ® Accesses the Output Channel Library. Click this button to open the
OUTPUT CH page of the Library window.

(® INPUT PATCH
Selects the input source assigned to the input channel (for the
selectable input sources, = p.22)
If multiple patches have been made, only the first port is shown.
If you change the patching in this window, the port that had been

assigned until then will be cancelled, and only the newly selected
port will be assigned.

ATO MATRIX

1O MATRIX send level
This adjusts the send level of the signal sent from the MIX channel to the MATRIX buses.

wll Select either PRE or POST as the position from which the signal is sent from the MIX
-8.65dE channel to the MATRIX bus. PRE POINT is selected if this is on, or POST FADER is
— selected if this is off. The PRE POINT setting can be made in the Mixer Setup dialogbox.

\[15 4 Right-click the PRE button to display a context-sensitive menu that will enable you
to specify ALL PRE, ALL POST, or other options.

e If you are using MATRIX buses in stereo, the knob for
the odd-numbered bus will be PAN.

Knob of odd-
numbered side

» The stereo/mono status can be specified in the Mixer
Setup dialogbox.
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(3® ON (MATRIX send on/off)
This is an on/off switch for the signal sent from the MIX channel to the MATRIX bus.

@ Channel name
This section indicates the MATRIX channel name.

ATO STEREO/MONO

Here you can specify how the signal will be sent from the MIX channel to the STEREO bus / MONO bus.
MODE

* ST/MONO button
When this button is on, the signal will be sent to the STEREO bus and independently to the MONO bus.

TO STEREQ/MONO

MODE

S5T/MONO

BALANCE

Adjusts the panning of the signal sent from the MIX channel to the STEREO bus L/R chan-
nels. You can set this to the center position by holding down the <Ctrl>(<38>) key of the
computer keyboard and clicking the knob. This is linked with the [PAN] encoder in the

PAN SELECTED CHANNEL section of the M7CL panel. If the selected MIX bus is used as a ste-
reo bus, the odd-numbered channel is fixed at L63 and the even-numbered channel fixed at
R63.

ST Switches the signal sent from the MIX channel to the STEREO bus on/off.

MONO Switches the signal sent from the MIX channel to the MONO bus on/off.

This is shown only if the selected MIX bus is assigned as a stereo bus. It adjusts the left/
BALANCE right volume balance of the stereo bus. You can set this to the center position by holding
down the <Ctrl>(<38 >) key of the computer keyboard and clicking the knob.

¢ LCR button

When this button is on, the signal will be sent to the L/C/R buses which work in conjunction with each other.

TO STEREQ/MONO

MODE
LCR

BALANCE

Adjusts the panning of the signal that is sent from the MIX channel to each of the L/C/R
channels. You can set this to the center position by holding down the <Ctrl>(<38 >) key of
the computer keyboard and clicking the knob. This is linked with the [PAN] encoder in the
SELECTED CHANNEL section of the M7CL panel. If the selected MIX bus is used as a ste-
reo bus, the odd-numbered channel is fixed at L63 and the even-numbered channel fixed at
R63.

PAN

This is shown only if the selected MIX bus is assigned as a stereo bus. It adjusts the left/
BALANCE right volume balance of the stereo bus. You can set this to the center position by holding
down the <Ctrl>(<38 >) key of the computer keyboard and clicking the knob.

Adjusts the proportion of the CENTER channel level relative to the STEREO bus L/R in a

CSR (Center Side Ratio) range of 0—100°%
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(JEQUALIZER

®
@
®
3. HIGH-MID—
2. LOW-MID —
1.88kH=|  A.AdE
= \
16AHz | +13.AdE
ATT— ®
A.AdE
(1O LIBRARY
Accesses the OUTPUT EQ page of the LIBRARY window.
@ON
Switches the EQ on/off.
® EQ graph

Indicates the response for the EQ of the currently selected channel. To reset the EQ to flat response, hold down
the <Ctr]>(<8>) key of your computer keyboard and click the graph.

@Q
5 FREQUENCY

(®) GAIN
These knobs adjust the Q, center frequency, and boost/cut amount for the four bands LOW, LO-MID, HI-MID,
and HIGH.

@[] HIGH shelving
If this button is on, the HIGH EQ will be switched to a shelving type (the Q knob of the HIGH EQ will disappear).

LPF (Low Pass Filter)
If this button is on, the HIGH EQ will function as a low pass filter. The Q knob of the HIGH EQ will disappear,
and the GAIN knob will act as the low pass filter on/off switch.

©®[=] (LOW shelving)
If this button is on, the LOW EQ will be switched to a shelving type (the Q knob of the LOW EQ will disappear).

HPF (High Pass Filter)
If this button is on, the LOW EQ will function as a high pass filter EQ. The Q knob of the LOW EQ will disappear,
and the GAIN knob will act as the high pass filter on/oft switch.

@ TYPE I/TYPE 1l (EQ type)
Selects either TYPE I (the algorithm used by previous digital mixers) or TYPE II (a newly developed algorithm) as
the EQ type.

@ ATT (Attenuation)

Adjusts the amount of attenuation/gain.
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ADYNAMICSI1

Except for the fact that the available types are COMPRESSOR, EXPANDER, COMPAND H and COMPAND §,
and that you can select more than one signal as the key-in signal, this is the same as the dynamics for input chan-
nels (> p.34).

(JINSERT

Except for the fact that the insert points that can be selected are different, this is the same as for the insert settings
of an input channel (= p.38).

JRECALL SAFE/MUTE SAFE

These are the same as the Recall Safe and Mute Safe functions for input channels.

RECALL SAFE———  SAFE
MUTE SAFE

AMUTE GROUP

Selects the mute group (1-8) to which the MIX channel belongs.

JdPan/Fader

1D ON
Switches the MIX channel on/off.

(@ Fader

Adjusts the output level of the MIX channel. A meter indicating the signal level is
shown at the right of the fader, and the current value is shown in the numerical box
immediately below. You can set this to the minimum value (e dB) by holding down
the <Ctrl>(<88>) key of your computer keyboard and clicking the fader knob, or set it
to the nominal value (0.00 dB) by holding down the <Ctrl>(<88>) key and <Shift> key
and clicking the fader knob.

(® CUE

This button cue-monitors the signal of the MIX channel.

A.AAdE
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If a MATRIX channel is selected

Selected Channel E@

CHANNEL —MMm DYMAMICS 1 TvFE COMPRES
iy

< WATRIX1
HT 1 -an

FROM MIX ST/MONOI(C)

e I
KEY IN

SOURGE
SELF PRE Ei

0 FREMUENCY
4. HIGH ( -
gEkiz T

1 INSERT— Ell
3. HIGH MID— - wWT [} FiINT
E76—| icoeiz] G936 NOKE -:Mml_l FRE FADER
2. LOW-MID — ! l GL a il
180Kz B.0dE 8

1. LOW-

ML LU= RECALL SAFE
0.8d8 MUTE SAFE

(ACHANNEL SELECT (Channel selection)

Except for the fact that your editing applies to a MATRIX channel, this is the same as the channel selection for a
MIX channel (= p.40).

(JFROM MIX, ST/MONO

- 14, £84E
5T L

(1) FROM MIX, ST/MONO send level
These adjust the send levels of the signals sent from the VARI type MIX buses or STEREO/MONO buses to the
MATRIX bus. The current value is shown in the numerical box immediately below.

(@ PRE(PRE/POST)
These select either PRE or POST as the position from which the signal is sent from the MIX buses or STEREO/
MONO buses to the MATRIX bus. PRE POINT is selected if this is on, or POST FADER is selected if this is off.
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(3 ON(FROM MIX, ST/MONO send on/off)
These are on/off switches for the signal sent from the MIX buses or STEREO/MONO buses to the MATRIX bus.

e If MIX buses and MATRIX buses are being used in stereo, the PAN (odd-numbered side)
odd-numbered knob will be PAN.

3 4
~ @
4 38dE
[

* If the FIXED type is selected for the MIX bus, only the ON but-

e The stereo/mono setting and the VARI type / FIXED type setting can be made in the Mixer Setup dialogbox.

@ Channel name
This section indicates the name of the MIX channel or STEREO/MONO channel.

(ABALANCE

TO STEREOQ/MONO

BALANCE

This is shown only if the selected MATRIX bus is being used as stereo. It adjusts the left/right volume balance of
the stereo signal. You can set this to the center value by holding down the <Ctrl>(<38>) key of your computer
keyboard and clicking this knob.

JEQUALIZER

This is the same as for the equalizer of a MIX channel (w p.42).

ADYNAMICSI1

Except for the fact that the available types are COMPRESSOR, EXPANDER, COMPAND H and COMPAND S,
and that you can select more than one signal as the key-in signal, this is the same as the dynamics for input chan-
nels (> p.34).

(JINSERT

Except for the fact that the insert points that can be selected are different, this is the same as for the insert settings
of an input channel (= p.38).

(JRECALL SAFE/MUTE SAFE

These are the same as the RECALL SAFE/MUTE SAFE of a MIX channel (= p.43).

AMUTE GROUP

These are the same as the MUTE GROUP of a MIX channel (= p.43).
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JFader

1 ON
This switches the MATRIX channel on/off.

@ Fader
This adjusts the output level of the MATRIX channel. A meter indicating the signal level
is shown at the right of the fader, and the current value is shown in the numerical box
immediately below. You can set this to the minimum value (—ee dB) by holding down
the <Ctrl>(<38>) key of your computer keyboard and clicking the fader knob, or set it
to the nominal value (0.00 dB) by holding down the <Ctrl>(<88>) key and <Shift> key
and clicking the fader knob.

(® CUE
This button cue-monitors the signal of the MATRIX channel.

A.a6de
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If a STEREO/MONO channel

is selected

® STEREO channel window

Selected Channel

4 5TL

CHANMEL ———————

PATCH
OMNI 5

TO STEREQO/MONO—————

MATRIX

BALANCE

-14 Badk
MT 1

Cxi)
LHIGHMD— ¢

ZLOW-MID— N

B.8dE

A.0dE

DYNAMICS 1 TYPE
g

i)
B -0 2
KEY IN
SOURGE
SELF PRE ED

INSERT
T

NOKE OMNWI 1 FRE FADER

L in & o

-GdB

RECALL SAFE—————
MUTE SAFE

A ade
GAIK

® MONO channel window

Selected Channel

‘CHANNEL

A NONDCC) >
Mano

TO MATRIX

3. HIGH-MID— 4

ATA
2.L0W-MID — 4

]

1.LOW- 4

B8dB

LXT]

DYMAMICS 1 TvFE [

8|

0 -an 20 18

KEY N - m/——

SOURCE
SELF PRE ER

INSERT————
T L] PONT
NONE OMNI 1 PRE FADER

LHAQ

RECALL SAFE
MUTE SAFE————

(ACHANNEL SELECT (Channel selection)

Except for the fact that your editing applies to a STEREO/MONO channel, this is the same as the channel selec-

tion for a MIX channel (= p.40).

ATO MATRIX

These are the same as the TO MATRIX of a MIX channel (= p.40).
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(ABALANCE (except for MONO channel)

TO STEREQ/MONO

BALANCE

Canter

This adjusts the left/right volume balance in the STEREO bus. You can set this to the center value by holding
down the <Ctr]>(<88>) key of your computer keyboard and clicking this knob.

(JEQUALIZER

This is the same as the equalizer settings of a MIX channel (= p.42).

ADYNAMICSI1

Except for the fact that the available types are COMPRESSOR, EXPANDER, COMPAND H and COMPAND S,
and that you can select more than one signal as the key-in signal, this is the same as the dynamics for input chan-
nels (> p.34).

(JINSERT

Except for the fact that the insert points that can be selected are different, this is the same as for the insert settings
of an input channel (= p.38).

(JRECALL SAFE/MUTE SAFE

These are the same as the RECALL SAFE/MUTE SAFE of a MIX channel (= p.43).

AMUTE GROUP

These are the same as the MUTE GROUP of a MIX channel (= p.43).

dFader
STEREO @ ON
This switches the STEREO/MONO channel on/off. This is
linked with the STEREO/MONO MASTER section [ON]
keys on the M7CL’s panel.
@ Fader

Adjusts the output level of the STEREO/MONO channel.
This is linked with the STEREO/MONO MASTER section
faders of the M7CL's panel. A meter indicating the signal level
is shown at the right of the fader, and the current value is
shown in the numerical box immediately below.

(3 CUE
This button cue-monitors the signal of the STEREO/MONO
channel. This is linked with the STEREO/MONO MASTER
section [CUE] keys on the M7CL’s panel.
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Library window

Library =5

DYNAMICS

Untitled 1.07C DYNAMICS [ED

INTERNAL DATA

TITLE TITLE R TYPE
Ducking Gate R | GATE
Bate L 7 Ducking R | ouckn
A.Dr.BD A.Dr.BD
A.Dr.SN GA | A.Dr.SN
De-Esser A De-Esser

Comp

Expand
Compander{H}
Compander(5)
A.DrBD
A.DrBD
A.Dr.5N
A.Dr.SN
A.Dr.SN
A.Dr.Tom
A.Dr.0verTop
E.B.Finger
E.B.Slap
Svn.Bass
Pianol

Piano2
E.Guitar
A.Guitar

Here you can edit the M7CLs various libraries. You can also load library files that were saved on a drive of your com-
puter, edit the order or title of library items, recall the desired library data, or copy desired library data to a library
within the M7CL.

This window is divided into DYNAMICS, INPUT EQ, OUTPUT EQ, EFFECT, GEQ, INPUT CH, and OUTPUT CH
pages; to switch pages, click the tabs located at the top of the window.

To display this window, choose [LIBRARY] from the [Windows] menu, and select either “DYNAMICS,” “INPUT
EQ,”“OUTPUT EQ,” “EFFECT,” “GEQ,” “INPUT CH,” or “OUTPUT CH.”

® ND FILE

(1) OPEN (Open a file)
Opens a library file located on a drive of your computer. Use this when you want to edit library data that you've
saved on a USB storage device.

(2 CLOSE (Close a file)
Closes the currently-open library file.

@) SAVE

Saves the currently-open library file on a drive of your computer. Use this to re-save an edited library on a USB
storage device, or to create a backup on the hard disk of your computer.

(9 SAVE AS (Save under a different name)

Saves the currently-open library file under a different name on a drive of your computer.

(B File name
Indicates the file name of the currently-open library.
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{2 (Effect/GEQ page only)

® )
—-
®
TVPE

Ducking DUCKING Sampling SN 2

Gate GATE Hip Comp 2

A.D-BD GATE Solo Vocall 2

A.Dr.SH BATE Solo Vocal2 2

De-Esser DE-ESER Ghorus 2
Click Erase
Announcer 2
Limiterl 2
Limiter? 2
Total Gomel 2
Total Gomp2 2
Gate
A.DrBD GATE
A.Dr.SN GATE
De-Esser DE-ES3ER

® FILE

This list shows the contents of the data in the library file you opened using the OPEN button ((1). The list
includes the following items.

(D No. (Number)

This column indicates the number of each item in the library.

TITLE

This column indicates the title assigned to each library item. You can also double-click this area and edit the title.

(© READ ONLY

Read-only data is indicated by an “R” in this column. It cannot be overwritten, nor can its title be edited.

TYPE

This column indicates the effect type.

In the case of dynamics, there is also an indication of the dynamics processor(s) of this channel into which each
library item can be recalled. Only library items with an indication of “1” can be recalled to DYNAMICS 1, and
only library items with an indication of “2” can be recalled to DYNAMICS 2. Library items with neither of these
indications cannot be recalled to this channel.

() DYNAMICS (DYNAMICS page only)

Select which of the two dynamics processors will be subject to the Store or Recall operation.

@ RACK No. (Rack selection) (Effect/GEQ page only)

Select which rack will be subject to the Store or Recall operation.
Wi HQ Pitch and Freeze cannot be recalled to an effect module mounted in Rack 6 or Rack 8.

(3 INTERNAL DATA
This area shows the M7CLs scene memory contents. The items displayed are the same as in the FILE list ((8)).

As desired, you can copy single or multiple scenes between the FILE list and the INTERNAL DATA list, and copy
or move them to a different location within a list.
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To do this, use the following methods to select the scene(s) that you want to copy or move.

¢ To select a single scene Total Conp1
Click the line containing the desired scene. Total Comn?

¢ To select multiple consecutive scenes
Click the first scene to select it; then hold down the <Shift> key and
click the last scene.

¢ To select multiple non-consecutive scenes

Click the first scene; then hold down the <Ctrl>(<88>) key and click
each of the remaining scenes.

Gate
Ducking
A.Dr.BD
A.Dr.SN

De-Esser

Total Comel
Total Gomp2
Gate
Duckins
A.Dr.BD
A.Dr.SN k
De-Esser

Total Comel
Total Gomp2
Gate

Ducking
A.Dr.BD
A.Dr.SN k
De-Esser

DUCKING
GATE

GATE
DUCKING
GATE
GATE
DE-E*

R co

GATE
DUCKING
GATE
GATE

DE-E*

When you have selected the scene(s) that you want to move or copy, drag them to the desired location in the other
list (if you're copying between lists) or in the same list (if you're copying/moving within the same list).

* To copy scenes (overwriting the destination) a0 T
Drag the copy-source scene(s) to the desired line in the other list or to YRR PrSrr e
another line in the same list. At this time, a B> symbol will appear at  [EYERI—-—=
the right of the scene number.

843 | Ducking DLCKING
When you drop the scene in this state, a dialog box will appear, asking | GATE
you to confirm the Save operation. If you click the OK button, the 0 GATE
copy-source scene(s) will be overwritten onto the copy-destination B46 De-Esser DE-ESSER

scenes, and the copy-source scene(s) will remain unchanged. (If the
copy-source selection contains multiple scenes, the data will be over-
written onto consecutive scenes starting at that scene.)

* To move scenes 040 Total Compl
Within the same list, you can move the selected scene(s) to another p41 | Total Cone?
location to rearrange the order of the scenes in the list. To do this, 842 | Gate

drag the selected scene(s) to a location between two other lines in the , i BUCKING
same list. At this time,a >— symbol will appear between the lines.

When you release the mouse button in this state, the selected scene(s)
will move to that location, and the scene numbers will also change D46  De-Esser DE-ESSER
accordingly. (If the move-source selection contains multiple scenes,

those scenes will be inserted consecutively at the location you specify.)

T.573 You cannot copy the InitialData of the GEQ library.
STORE

Stores the current settings to the data item that is selected in the list.

15 RECALL
Recalls the data item that is selected in the list.

CLEAR
Clears the data item(s) selected in the list. (The title of the cleared item(s) will be reset to [No Data!].)

@ UNDO
Cancels the last-performed library recall, store, copy, or move operation.
You can click this repeatedly to repeat Undo and Redo.

51 M?7CL V3 Editor Owner’s Manual



Patch Editor window

Here you can assign the input/output port for each channel, its direct output, and its insert-in/out.
This window is divided into INPUT PATCH, OUTPUT PATCH, INPUT INSERT PATCH, OUTPUT INSERT PATCH,
DIRECT OUT PATCH, and PATCH LIST pages. To switch pages, click the tabs shown in the upper part of the window.

To display this window, choose [PATCH Editor] from the [Windows] menu, and select either “INPUT PATCH,”
“OUTPUT PATCH,” “INPUT INSERT PATCH,” “OUTPUT INSERT PATCH,” “DIRECT OUT PATCH,” or “PATCH
LIST”

INPUT PATCH page

Patch Editor ==

m

Here you can select the input port that is assigned to the input of each input channel.

(JPRESET

Initializes the patching in this page.

(ACLEAR ALL

Clears all patching in this page.
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OUTPUT PATCH page

" Patch Editor ==
(] -
<] [] i
(] (]
(] (]
@
@
® )
(] O
] ® ]
@ ® e
@ C] Ol
® a
0
@
(]
(]
®
Here you can select the input port that is assigned to the output of each output channel.
INPUT INSERT PATCH page
Patch Editor ==z

INSERT OUT

INFUT INSERT FRTCH

INSERT IN

11213 1516/ 1 2 3

Output port selection

Input port selection

Here you can assign input/output ports to the insert-in/out of each input channel. Select the output port in the left
side of the screen, and the input port in the right side of the screen.
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OUTPUT INSERT PATCH page

Patch Editor ==

QUTPUT INSERT PATCH

INSERT OUT INSERT IN

1
8818 11121314 1516/ 1 | 2| 3|4 1023 % 5 6 7831811121314 1516 1 2|3

Output port selection Input port selection

Here you can assign input/output ports to the insert-in/out of each output channel. Select the output port in the left
side of the screen, and the input port in the right side of the screen.

DIRECT OUTPUT PATCH page

Patch Editor =l=/E

1

Here you can select the output port that will directly output each input channel.
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PATCH LIST page

~ Patch Editor ==

PATEH LIST

Here you can view and edit the input patch and output patch settings.

OMiI 2

CH 1 |ch 1
3 QMK L

Q) maj—

U

(O Input channel number

@ Input channel name
This is the number and name of the input channel. You can click the channel name box to edit the name in this

page.
 Input port
This shows the input port assigned to the input channel. You can click this box and choose the input port from
the popup menu that appears.
(9 Output channel number

(® Output channel name
This is the number and name of the output channel. You can click the channel name box to edit the name in this

page.
(6 Output port
This shows the output port assigned to the output channel. You can click this box, then choose or cancel the out-
put port from the popup menu that appears.

573 You can assign multiple output ports.
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Rack window

Rack ==E

GER / EFFECT

(5] [} [}
4E NENE B EEE D EhE
Un-& Ua"w uﬂ_” Un-‘

IN OuT

LFLR

IN OuT

LRLR

il

LRLR

A

I

LFLR

Here you can make settings for GEQ, effects, and external head amps.
This window is divided into GEQ/EFFECT and EXTERNAL HA page (M7CL-32/48) or EXT-ES HA page (M7CL-
48ES). To switch pages, click the tabs located at the top of the window.

GEQ/EFFECT page
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1) Mount

Select a GEQ module or effect module for mounting in the rack, from the following choices.

BLANK No assignment

31BandGEQ 31-band 1-in/1-out graphic equalizer

2-in/2-out graphic equalizer that allows any fifteen of the 31

Flex15GEQ bands to be controlled

EFFECT Internal effect (only for RACK 5-8)

@ Input patch
Select the input port(s) that will be assigned to the rack, from the following choices.

NONE No assignment

MIX 1-16 MIX channel 1-16

MATRIX1—8 MATRIX channel 1-8

ST L, ST R, MONO(C) STEREO channel L/R, MONO channel

INS CH 1-48(*) INPUT CH 1-48(*) insert in

INS MIX 1-16 MIX channel 1-16 insert in

INS MATRIX1-8 MATRIX channel 1-8 insert in

:\;lgl\;sg(é’) INS ST R, INS Insert-in of STEREO channel L/R or the MONO channel

() INPUT CH 33-48 can be viewed during offline editing only if “M7CL-48” or “M7CL-48ES” is selected in the System Setup dialog box.
It can also be viewed during online editing for the M7CL-48 or M7CL-48ES.

This is not shown if nothing is mounted in the rack.

(® Module graphic
This area shows a graphic of the GEQ module or effect module that is currently assigned to the rack, and the
parameters of that module. You cannot edit the parameters in this screen.

Double-click this to open the module editor for that rack unit.

By holding down the <Ctrl>(<88>) key of your computer keyboard and double-clicking this, you can open mul-
tiple rack module editors. For these additional editors, the rack select buttons are not linked with the RACK
popup window of the M7CL itself.

(@ Input meter/Output meter
These indicate the level of the signals being input and output from the rack.

(5 Output patch
Select the output port(s) that will be assigned to the rack, from the following choices.

NONE No assignment

CH 1-48(*) INPUT CH 1-48(*)

STIN1L-STIN4R ST IN channel 1-4 (L/R)

INS CH 1-48(* INPUT CH 1-48(*) insert out

INS MIX 1-16 MIX channel 1-16 insert out

INS MTRX1-INS MTRX8 MATRIX channel 1-8 insert out

:\TSNS(-)I—(IC-)) INS STR, INS Insert-out of STEREO channel L/R or the MONO channel

(*) INPUT CH 33-48 can be viewed during offline editing only if “M7CL-48” or “M7CL-48ES” is selected in the System Setup dialog box.
It can also be viewed during online editing for the M7CL-48 or M7CL-48ES.

(® ON, BYPASS
This switches the GEQ module or effect module between active and bypassed states.
A GEQ module is active when the ON button is lit.
An effect module is active when the BYPASS button is dark.
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Rack module editor — GEQ window

® 31BandGEQ

Rack Medule Editor @@

GEQ LINK [ENEND

- BB
QUTPUT

® Flex15GEQ

Rack Medule Editor @@

GEQ LINK [ENEND
AILAELE

L] +18.3

OUTP:;.:JT

A B

In this window you can select the insertion destination of GEQ, and edit the parameters.

(1) Rack No. (Rack selection)

Select the rack module that you want to control.

(@ LIBRARY
This button accesses the GEQ library. Clicking this button
will open the GEQ page of the LIBRARY window.
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(® Input patch
Click the CHANNEL field, and choose one of the following as the signal route that will
be patched to the input channel(s) of the currently selected GEQ module.

NONE No assignment

MIX 1-16 MIX channel 1-16

MATRIX1—8 MATRIX channel 1-8

STL, ST R, MONO(C) STEREO channel L/R, MONO channel

INS CH 1-48(*) INPUT CH 1-48(*) insert in

INS MIX 1-16 MIX channel 1-16 insert in

INS MATRIX1-8 MATRIX channel 1-8 insert in

INS ST L, INS ST R, INS MONO(C) | Insert-in of STEREO channel L/R or the MONO channel

(*) INPUT CH 33-48 can be viewed during offline editing only if “M7CL-48” or “M7CL-48ES” is selected
in the System Setup dialog box. It can also be viewed during online editing for the M7CL-48 or M7CL-
48ES.

The channel name is shown in the boxes immediately below.

@ Input meter
This indicates the level of the signal that is being input to the currently selected GEQ
module.

(5 Output patch
Click the CHANNEL field, and choose one of the following as the signal route that will
be patched to the output channel(s) of the currently selected GEQ module.

NONE No assignment

CH 1-48(*" INPUT CH 1-48(*)

STIN1L-STIN4R ST IN channel 1-4 (L/R)

INS CH 1-48(*) INPUT CH 1-48(*) insert out

INS MIX 1-16 MIX channel 1-16 insert out

MATRIX INSERT1-8 MATRIX channel 1-8 insert out

INS ST L, INS ST R, INS MONO(C) Lneslert-out of STEREO channel L/R or the MONO chan-

() INPUT CH 33-48 can be viewed during offline editing only if “M7CL-48” or “M7CL-48ES” is selected
in the System Setup dialog box. It can also be viewed during online editing for the M7CL-48 or M7CL-
48ES.

The channel name is shown in the boxes immediately below.
(6) Output meter

This indicates the level of the signal that is being output to the currently selected GEQ
module.
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® 31BandGEQ

GEQ LINK

® Flex15GEQ

GEQ LINK

zok  AMAILRELE
. MOS

=73 0.8 +14.5 L] 8.8 a.8 0.8 L] L] B8 -38 fal a8 L] +7.3

(D ON (GEQ on/off)
Switches the currently selected GEQ module on/off.

LINK

This button links the settings of two adjacent odd-numbered/even-numbered 31BandGEQ modules, or the group
A and group B settings of a Flex15GEQ. When you click this button, a window will ask you for confirmation.
Click the buttons for the modules you want to use as the parameter copy-source and copy-destination. If you click
the RESET BOTH button, the parameters of both modules will be reset to the default state.

(®© GEQ graph
This graph shows the response of the currently selected GEQ module.

GEQ faders
These faders cut/boost the frequency bands of the GEQ module. The value of each fader is shown in the numeri-
cal box below it. Hold down the <Ctrl>(<38>) key and click to set the value to 0.00 dB.

() EQ FLAT
This button resets all GEQ faders to the 0 dB position.

( AVAILABLE BANDS (number of operable bands) (Flex15GEQ only)
For a Flex]15GEQ, you can operate any fifteen of the thirty-one bands. This numerical display box shows the
remaining number of bands that can be operated. If you have operated fifteen bands, this number will be zero,
and you won’t be able to operate any additional bands. If you want to operate another band in this state, you’ll
need to return a previously-operated band back to the 0 dB position.
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Rack module editor — Effect window

Rack Module Editor @@

L CHANNEL
HOKE

R CHAWMEL

Rack Module Editor @@

RACK | ERYAMAHA REV=<X HALL |
No.  [ESW

Reverb Time HPF
Initial Delay LPF
EFFECT NAME i a Ak Decay B Hi Ratio
Room Size Low Ratio

Diffusion . Low Freq

Hi Ratio[
Low Ratio[ 12]
HPE Diffusion[18]
[ Thea ]
1k,

100,

QUTPUT

i}

L CHANKMEL
NONE
4 Reverb Time[

Fi CHANNEL
NONE

[l

Here you can select the effect type for an internal effect, edit the parameters, and specify the input/output patching.
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(1) Rack No. (Rack selection)

Select the rack module that you want to control.

(@ BYPASS
This button temporarily bypasses the effect.

(® CUE

This button cue-monitors the output of the currently selected
effect.

® (49 EFFECT NAME
Indicates the title of the currently selected effect.

REERE HALL 11Ks20UT

(5 EFFECT TYPE

Indicates the currently selected effect type. You can also switch the effect type from this window. To do so, click
the text box, and select the desired effect type from the popup menu that appears.

(® LIBRARY
This button accesses the effect library. Clicking this button will open the EFFECT page of the LIBRARY window.

@ Input patch
Click the L CHANNEL or R CHANNEL area, and choose one of the
following as the signal route that will be patched to the L/R input chan-
nels of the internal effect.

®) NONE No assignment

@ MIX 1-16 MIX channel 1-16
MATRIX1-8 MATRIX channel 1-8
ST L, ST R, MONO(C) STEREO channel L/R, MONO channel
INS CH 1-48(*) INPUT CH 1-48(*) insert in
INS MIX 1-16 MIX channel 1-16 insert in

L CHANNEL g INS MATRIX1-8 MATRIX channel 1-8 insert in
=11 2 INS STL, INS STR, INS | Insert-in of STEREO channel L/R or the MONO
: 10 MONO(C) channel
©

(*) INPUT CH 33-48 can be viewed during offline editing only if “M7CL-48” or
“M7CL-48ES” is selected in the System Setup dialog box. It can also be viewed dur-
ing online editing for the M7CL-48 or M7CL-48ES.

D The channel name is shown in the boxes immediately below.

Input meter

Indicates the level of the signal being input to the internal effect.

(© Output patch
Click the L CHANNEL or R CHANNEL area, and choose one of the following as the signal route that will be
patched to the L/R output channels of the internal effect.

NONE No assignment

CH 1-48 INPUT CH 1-48(*)

STIN1L-STIN4R ST IN channel 1-4 (L/R)

INS CH 1-48(*) INPUT CH 1-48(*) insert out

INS MIX 1-16 MIX channel 1-16 insert out

MATRIX INSERT1-8 MATRIX channel 1-8 insert out

INS ST L, INS ST R, INS MONO(C) Insert-out of STEREO channel L/R or the MONO channel

(*) INPUT CH 33-48 can be viewed during offline editing only if “M7CL-48” or “M7CL-48ES” is selected in the System Setup dialog
box. It can also be viewed during online editing for the M7CL-48 or M7CL-48ES.
The channel name is shown in the boxes immediately below.
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Output meter

Indicates the level of the signal being output from the internal effect.

() Parameter display select button
If “046 REV-X Hall,” “047 REV-X ROOM,” “048 REV-X PLATE,” or VCM effect is selected as the effect type, this
button switches between the standard parameter screen and a dedicated GUIT screen.

Ml (129 MIX BALANCE

Adjusts the balance of the effect sound relative to the original sound. 0 (%) outputs
only the original sound, and 100 (%) outputs only the effect sound.

i3 TEMPO
If a tempo-type or modulation-type effect is selected, this allows you to adjust time-
related parameters such as DELAY (delay time) and FREQ. (modulation speed).
To set the value of the TEMPO parameter, you can either input the BPM (Beats Per
Minute) in the numerical box, or repeatedly click the TAP TEMPO button at the
desired tempo.
If the MIDI CLK button is on, the TEMPO parameter value will synchronize to the
MIDI timing clock being received from the MIDI port.

128 BFM

SOLO
If “044 M.BAND DYNA” or “045 M.BAND COMP” are selected as the effect type, these
buttons allow you to monitor only the specified band from the three bands HIGH,
MID, and LOW.

15 GR meter
If “044 M.BAND DYNA” or “045 M.BAND COMP” are selected as the effect type, this
indicates the gain reduction amount for the H (HIGH), M (MID), and L (LOW) bands.

PLAY/REC (Play/Record) buttons
If “042 FREEZE” is selected as the effect type, you can use these buttons to record and play back the signal being
input to the effect.

() Effect parameters
This area shows the effect parameters and knobs for the currently selected effect type.
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EXTERNAL HA/EXT-ES HA page

Rack =EE

EXTERNAL HA

48V 48V

oM

Ade  -7dB  +1dB

F®:E:®

2dB  +18dB  +18dB

48V 48V 48V aav

E2NONANO)

+2dB  +1dE  +3dE  +16dE  -TdE

48V 48V 48v

O

+8dE | +1dE

The EXT-ES HA page features VIEW switch buttons. Use these buttons to select the virtual rack display
for SB168-ES or for others (AD8HR). If only the SB168-ES is connected, select the virtual rack display for
SB168-ES.

48y 48Y

OO

+2dé  +EdE | +4dEB  +5dE +1AdE +18dE +1AdE

1) External HA name
This shows the model name and ID number of the currently connected external head amp device.

@ GAIN

This specifies the gain for each channel. The current value is shown in the box below.

348V
This switches the phantom power (+48V) on/off for each channel.

(® HPF (High Pass Filter)
This switches the HPF on/off for each channel.

(5 +48V MASTER
If an AD8HR is connected, this indicates the on/off status of the master phantom power supply.

(® Slots/Channels

Here you can select the slots/channels to which the audio outputs of the external head amp device are connected.
On the M7CL-48ES, the EXT-ES HA assignment is fixed.

NONE SLOT2 9-16
SLOT1 1-8 SLOT3 1-8
SLOT1 9-16 SLOT3 9-16
SLOT2 1-8
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Meter window

This window shows the signal levels of each section in the M7CL, letting you check for the presence of signals and
whether an overload is occurring.

This window is divided into INPUT METER and OUTPUT METER; to switch pages, click the tabs located at the top
of the window.

IY:.573 In order to view the M7CL’s signal levels in the Meter window, make sure that M7CL Editor and the M7CL
itself are synchronized.

INPUT METER page

P 7

LEVEL METER =METERING POINT

Meter ==

INPUT METER

QuER

‘ ®
FEEEEEEEEEEEE R

i R 2L 2R 3L 3R 4L 4R
—_— ST IN——————

33 34 35 36 37 38 39 41 42 43 44 45 46 47 48

(1) METERING POINT
Select one of the following as the point where metering will occur.
PRE HPF, PRE FADER, POST ON

@ PEAK HOLD
Switches peak hold on/off.

(3 Meters
These peak level meters show the input level of each channel. The current fader value is shown in the box below.
If clipping occurs at any one of the detection points in the channel, the X segment will light.
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OUTPUT METER page

? 9

Meter

OUTPUT METER

LEVEL METER METERING POINT

Fos

=

=

(D METERING POINT

Select one of the following as the point where metering will occur.
PRE EQ, PRE FADER, POST ON

@ PEAK HOLD

This is the same as in the INPUT METER page.

(3 Meters

This is the same as in the INPUT METER page.

66

M7CL V3 Editor Owner’s Manual



Group/Link window

In this window you can select the channels that will be assigned to each DCA group and mute group. This window is

divided into three pages; the DCA GROUP ASSIGN page, the MUTE GROUP ASSIGN page and CHANNEL LINK
page.

DCA GROUP ASSIGN page

Groupy/Link

==E

B 7 & 918 1112 13 14 15 16 171
1

Here you can specify the channels that will be assigned to DCA groups 1-8.

INPFUT DCA

INPUT CH
78 8918 1112 1314 15 16 17 18 19 28 2122 23 24 25 2

(O DCA group
This is the number of the DCA group.

(@ DCA group name
This is the name of the DCA group. You can also click the mouse on this area to edit the name.
® Grid

This grid lets you assign channels (horizontal rows) to DCA groups (vertical columns). Currently-patched grids
are indicated by a © symbol. To enable or disable an assignment, click the desired grid.

@ CLEAR

These buttons clear all channels assigned to the corresponding DCA group. When you click one of these buttons a
window will appear, asking you to confirm the operation. To execute the Clear operation, click the OK button.
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MUTE GROUP ASSIGN page

Group/Link ==

MUTE GROUP ASSIGN

INPUT MUTE

Here you can specify the channels that will be assigned to mute groups 1-8. The upper part of the screen lets you
assign input channels to mute groups, and the lower part of the screen lets you assign output channels to mute
groups.

INFUT MUTE

(1) Mute group

This area shows the mute group number.

@ MUTE MASTER
These buttons enable/disable each input channel or output channel mute group.

3 Grid
This grid lets you assign channels (horizontal rows) to mute groups (vertical columns). Currently-patched grids
are indicated by a i symbol. To enable or disable an assignment, click the desired grid.

(& MUTE SAFE ON

These buttons switch Mute Safe on/off for each channel. Channels for which this button is on will be excluded
from mute groups.

() CLEAR

These buttons clear all input channels and output channels assigned to the corresponding mute group. When you
click one of these buttons a window will appear, asking you to confirm the operation. To execute the Clear opera-
tion, click the OK button.
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CHANNEL LINK page

Group/Link S=E

CHANNEL LINK

LINK PARAMETER

[~ | = Jrecfree] s Bar o]

SEND PARAMETER
TO MIX

MIX 1
MIX 9

TO MATRIX

MATRIX1 MATRIX2 MATRIX3 MATRIX4 MATRIXS MATRIXE MATRIXT MATRIXS

If you link two or more input channels, the parameters of these channels will interlock with each other and change
simultaneously.

ILINK PARAMETER

DYNAMICSE | DYNAMICS MATRIX
“ﬂm SEND m 1 on

[SEND PARAMETER

TO MIX

MIX 1

MiX 9

TO MATRIX

MATRIX1 MATRIXZ MATRIX3 MATRIX4 MATRIXS MATRIXE MATRIXT MATRIX8

@ Link buttons

Use these buttons to select the link group A—Z *) to which you want each input channel to be assigned. If you
don’t want an input channel to be linked, select NONE. You can assign up to twenty-four (*) groups for INPUT
CH 1-48, and up to two groups for ST IN channels.

(*) During offline editing when M7CL-32 is selected in the System Setup dialogbox, or during online editing with the M7CL-32 con-
nected, up to sixteen groups can be assigned for INPUT CH 1-32, and you’ll be able to choose from link groups A-R.

(@ CLEAR ALL

Clears the link settings for all channels.
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(® LINK PARAMETER

This section enables you to select the parameters to interlock.

HA Head amp gain and phantom power settings
ATT Attenuation value

EQ Equalizer settings

DYNAMICS1 Dynamics 1 settings

DYNAMICS2 Dynamics 2 settings

MIX SEND Send amount from input channel to MIX bus

MIX ON MIX SEND on/off

MATRIX SEND | Send amount from input channel to MATRIX bus

MATRIX ON MATRIX SEND on/off
FADER Fader level value
CH ON Input channel module output on/off

() INPUT CH 33-48 can be viewed during offline editing only if “M7CL-48” or “M7CL-48ES” is selected in the System Setup dialog box.
It can also be viewed during online editing for the M7CL-48 or M7CL-48ES.

.Y 74 The HA and FADER parameters will maintain level differences between linked channels.

(49 SEND PARAMETER
Specify the link status for each MIX/MATRIX SEND bus.
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Scene window

Here you can manage scene memories, and make various settings related to scene recall operations.

This window is divided into SCENE MEMORY, RECALL SAFE, and FADE TIME pages. To switch pages, click the
tabs shown in the upper part of the window.

SCENE MEMORY page

Scene

SCENE MEMORY

Untitled 1.M70

No. TITLE
881 Scene BB1
882 Scene BB2
883 Scene BO3

2] CONMENT
Scene 881
Scene 082

. Scene 883

No. TITLE
8088 | Initial Data
881 | Scene 881
882 | Scene 882
8083 | Scene 03

[=/EEs

INTERMAL DATA

2] COMMENT
R | Initial Settina Data
Scene 801
. Scene 802
Scene 883

Here you can edit the M7CL’s scene memories. You can also load scene library files from a USB storage device or
from a drive of your computer, and edit them. In this case, you can re-save all scenes to a file after editing, recall just
a desired scene, or copy a desired scene to the scene memory of the M7CL itself.

FileBB1.M7C

No. TITLE
A81  Scenebdl
0882 | SceneBB?2
883 | SceneBB3
o4

865

Af6

(3] COMMENT
Scenefl
SceneBB2

. Scenebdd

71

(1) File name

Indicates the file name of the currently-open
scene library.

(2 OPEN (Open a file)

Opens a scene library file located on a drive of
your computer.

(3 CLOSE (Close a file)

Closes the currently-open scene library file.

(@ SAVE

Saves the currently-open scene library file on a
drive of your computer.

(5 SAVE AS (Save as a different

name)
Saves the currently-open scene library file under
a different name on a drive of your computer.
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® FILE
This area lists the scenes in the file you opened using the OPEN button ((2)). The list includes the following items.
"I To view items that are not currently shown, scroll the list to the right.

No. TITLE & COMMENT TINE STANP FADING | FADE TINE
B0 | Initial Data R | Initial Settins Data [ A | B.8s

881 | Sceneddl Sceneffl En 68/01/2085 08:08:00 21.9s
002 | Scened2 B sceneoo? [rack | | [ w [ our ] as/01/2005 oe-00:00 [EEEEN  21.9s
003 | Scened3 SceneBf3 ESEN . ER - EEE 0s/01/2605 00:00:00 21.9s

684
685
086
Be7
688
[i5k)
618

@ No.

This is the scene number.

TITLE

This is the scene title. You can also double-click this area and edit the title.

© PROTECT

This indicates whether protect is on or off for each scene. This area displays a lock icon for protected scenes; these
scenes cannot be overwritten, nor their title edited. Read-only scenes are indicated by “R” displayed in this col-
umn.

COMMENT

This column shows the comment assigned to each scene. You can also double-click this column and edit the com-
ment.

@ FOCUS

From the following list, choose the parameters that will be recalled by a Scene Recall. If you select ALL, the other
buttons will be unavailable. Multiple selections are allowed for buttons other than ALL.

ALL All the settings of the scene will be recalled

RACK GEQ and internal effect settings will be recalled

HA Internal head amp and external head amp settings will be recalled
IN PATCH Input patch settings will be recalled

OUT PATCH Output patch settings will be recalled

Input channels (INPUT, ST IN, DCA) settings will be recalled except for head
amp settings

ouT Output channel (MIX, MATRIX, STEREO/MONO) settings will be recalled
WITH SEND(*) | Send settings to the output channels will be recalled

IN

(*) Can be selected only if OUT is selected
(@ TIME STAMP

Indicates the time at which the scene was last stored, in the format of month/day/year/hours/minutes/seconds.
This column is only for display, and cannot be edited.

@ FADING

This switches fading on/off for each scene.

FADE TIME
Indicates the FADE TIME for each scene. You can edit the FADE TIME by double-clicking this field.
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TITLE = COMMENT
Initial Data R | Initial Settina Data
SceneBl SceneBdl

ScenefB2 . Sceneff2
Sceneddd

@ INTERNAL DATA
This area shows the M7CL’s scene memory contents. The items displayed are the same as in the FILE list ((§)).

As desired, you can copy single or multiple scenes between the FILE list and the INTERNAL DATA list, and copy
or move them to a different location within a list.

STORE

Stores the current settings to the scene that is selected in the list.

@ RECALL

Recalls the settings of the scene selected in the list.

CLEAR
Clears the scene(s) selected in the list. (The title of the cleared scene(s) will be reset to [No Data!].)

UNDO

Cancels the last-performed scene recall, store, copy, or move operation.

@ PROTECT

Turns on the Protect setting for the scene(s) selected in the list.
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RECALL SAFE page

RECALL SAFE

INPUT SAFE PARAMETERS

£ SHFE ONJOFF

T HLL
CLEAR ALL

=EE

OUTPUT SAFE PARAMETERS GLOBAL RECALL SAFE

INPUT INFUT
PATCH NAME
OUTPUT OUTPUT
PATCH NAME

LEVEL/ON

3

4 ALL

5 LEVEL/ON

B ALL

7 ALL

8 ALL

Here you can make settings for the Recall Safe function that excludes only specific channels from recall operations of

all scenes.

e oo o6 oo 6

(DOINPUT SAFE PARAMETERS
In this area you can view and edit the Recall Safe settings for
all input channels and ST IN channels. This area contains the
following items.

(@ SAFE ON/OFF

These are on/off buttons that select the channels to be
excluded from recall operations.

(®Parameter matrix grid
Here you can select the parameters to be excluded from recall
operations. If the ALL button is on, all parameters will be
excluded.

@SET ALL

These buttons turn on all buttons for all input channels or ST
IN channels, or for the corresponding parameter.

(5 CLEAR ALL

These buttons turn off all buttons for all input channels or ST
IN channels, or for the corresponding parameter.
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OUTPUT SAFE PARAMETERS GLOBAL RECALL SAFE

INP
PATCH NAME
QUTPUT QUTPUT
PATC NAME

3 MT 3
4 MT U
3 MT 5
Ml &
MT T
MT &

SET ALL
CLERR ALL

(6 OUTPUT SAFE PARAMETERS
In this area you can view and edit the Recall Safe settings for all output channels. The items in this area are the
same as in the Input Safe Parameters area ((1)).

(D) GLOBAL RECALL SAFE
In this area you can view and edit the Recall Safe settings for patching, DCA groups, and racks.

INPUT PATCH
This on/off button specifies whether INPUT PATCH settings will be excluded from recall operations.

(@ INPUT NAME

This on/off button specifies whether the channel names of input channels will be excluded from recall operations.

OUTPUT NAME
This on/off button specifies whether the channel names of output channels will be excluded from recall opera-
tions.

() OUTPUT PATCH
This on/off button specifies whether OUTPUT PATCH settings will be excluded from recall operations.

2 DCA
These buttons exclude DCA groups from recall operations. If the ALL button is on, the LEVEL, ON, and DCA
group names will be excluded. If the LEVEL/ON button is on, LEVEL and ON settings will be excluded.

@ RACK
This on/off button specifies whether RACK settings will be excluded from recall operations.

SET ALL

This button switches on all buttons for parameters 8—13.

{ CLEAR ALL

This button switches off all buttons for parameters 8—13.
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FADE TIME page

Scene ==&

FADE TIME

MIX
e ] ]
—— STEREO/MONO—

FADE TIME

FapinG IERRSEEN °
21.3s

Here you can make settings for the Fade Time function which adjusts the time over which fader and pan will reach
their new values when a scene is recalled. Since the Fade function settings are independent for each scene, you must
recall the desired scene before you make these settings.

(O INPUT CHANNEL FADING ENABLE

These on/off buttons select the input channels that will be excluded from recall operations.

(@ SET ALL

This button switches on the buttons of all input channels.

(3 CLEAR ALL
This button switches off the buttons of all input channels.
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STEREQ/MONO —

FADE TIME

FADING [NENIRSEEN °

@

(4 OUTPUT CHANNEL FADING ENABLE

These are on/off buttons that select the output channels that will be excluded from recall operations.

& SET ALL

This button switches on the buttons of all output channels.

(® CLEAR ALL
This button switches off the buttons of all output channels.

(D) FADING ENABLE

This button enables/disables the Fade function for the faders of the current scene.

FADE TIME

Drag this knob in the screen to adjust the fade time. The current value is shown in the numerical box immediately
below.
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User Defined Keys Setup window

In this window, you can specify the functions or parameters to be assigned to the User Defined keys.

User Defined Keys Setup

GURRENT USER: Administrator EDIT | Adninistrator

1 MIXONFADER 2 MATRIX ON FADER 3 PAGE BODKMARK 4

PAGE BOOKMARK PAGE BOOKMARK PAGE BOOKMARK

9 | MUTE GROUP 1 MUTE GROUP 2 MOMENTARY

TR wosorwn W Wsousorom WP oocomer W Prcome

i COT i I O T

= O = OO S T T

=E

PAGE BOOKMARK

PAGE BOOKMARK

TALKBACK ON
UNLATGH

INPUT CH 33-48 can be viewed during offline editing only if “M7CL-48" or “M7CL-48ES” is selected in the
System Setup dialog box. It can also be viewed during online editing for the M7CL-48 or M7CL-48ES.

(1) CURRENT USER

Displays the name of the user currently logged into the M7CL console. If the M7CL has not yet been synchro-

nized with the Editor, this field displays “Administrator.”
Q@ EDIT

Displays and enables you to specify the user level (Administrator, Guest, or Ext.User) of the User Defined keys

that you are editing.

“Ext.User”is the user who is currently logged into the M7CL console via a user authentication key stored on a USB
storage device. You can select this user only when the M7CL console is synchronized with the Editor.

I.573l Ext.User’s User Defined key settings will not be stored in a session file.

(3 Function names

Select the functions or parameters you wish to assign to the User Defined keys.

Click a User Defined key to open the Parameter List dialog box.

For more information on the assignable parameters, please refer to the “M7CL Version3 Owner’s Manual.”
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Sends On Fader window

—MATRIX——
MT 1 MT 2

MT = MT 4
MT SiMT &
MT 74MT &

SENDS ON FADER mode enables you to adjust the send level to the MIX/MATRIX bus using the fader. In this mode,
the signals sent from all input channels to a specific MIX/MATRIX bus can be adjusted simultaneously.

Use the SENDS ON FADER button in the Master window to switch this mode on and off.

To display this window, do one of the following:

Select [Sends on Fader] in the [Windows] menu.
Click the SENDS ON FADER button in the Master window.

In SENDS ON FADER mode, the color and function of the [ON] button and the fader in the Overview window will
change.

Color of the send destination | Send is on.
[ON] button -
Gray Send is off.
Fad Color of the send destination | The signal is sent to the bus.
ader
Gray The signal is NOT sent to the bus.

Click the button (in the Sends On Fader window) for the MIX/MATRIX bus for which you want to adjust the send
level. Then switch the send level off or on, and adjust the send level using the [ON] button and fader for the input
channel displayed in the Overview window.

For MATRIX bus send, not only the input channels but MIX channels and STEREO/MONO channels can
be in SEND ON FADER mode.
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Output Port window

In the Output Port window you can assign the source channel for each output port and set the parameters.

Output Port @@

OMNI 1-2

—@
—@
—®
—0©
—®

45985 = | 6299 2 | 2918
¥ i

ms s
DELAY DELAY DELAY DELAY DELAY DELAY DELAY DELAY
TIME 7 TIME \ TIME = TIME TIME e TIME ra TIME @

85 A~ | smes A | 2oem 3019 18 4

sanele ¥ sanele ¥ sanele ¥ SAMnFle sanrle ¥

—©
—®

68 db | B g 0.8 db | B g C ca 68 db

®

—®

The window includes the following items.

(1) Output port select tabs

These tabs switch the output ports controlled in the window in groups of up to eight ports.

(2 DELAY SCALE field
Here you can select the units for the delay time shown below the delay time knob ((8)).

*METER(343.59m/s)

The delay time is shown as a distance in meters, calculated as the speed of sound (343.59 m/s) at an air temperature of 20°C
(68°F) multiplied by the delay time (seconds).

*FEET(1127.26ft/s)

The delay time is shown as a distance in feet, calculated as the speed of sound (1127.26 feet/s) at an air temperature of 20°C
(68°F) multiplied by the delay time (seconds).

*SAMPLE

The delay time is shown as a number of samples. If you change the sampling frequency at which the M7CL operates, the
number of samples will change accordingly.

*msec
The delay time is shown in units of milliseconds. If this button is on, the same value is displayed above and below the delay

time (@).
(® Output port

This indicates the type and number of the output port to which the channel is assigned.

(4@ Channel select button
This button lets you select the channel that is assigned to the output port.

(3 Channel name
Indicates the name of the channel that is assigned to the corresponding output port.

(6) DELAY button
Switches the output port delay on/off.
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(D) Delay time
The millisecond delay time value is shown above the knob.

The delay time value in the units selected in the DELAY SCALE field ((2)) is shown below the knob.
Click the A/¥ buttons to make detailed settings.

Delay time knob
This knob sets the delay time of the output port. Rotate (by dragging) this knob to set the delay time.

(® @(Phase) button

Switches the phase of the signal assigned to the output port between normal phase (black) and reverse phase
(orange).

ATT knob

Adjusts the amount of attenuation for the signal assigned to the output port. To change the value, rotate (by drag-
ging) the knob in the screen. You can adjust the setting in 0.1 dB steps over a range of =96 to +24 dB. The current
value is shown immediately below the knob.

i) Level meter
This meter indicates the level of the signal assigned to the output port.

81 M?7CL V3 Editor Owner’s Manual



Keyboard Shortcuts

Key operation

Menu Action
Windows Mac
Creates a new Session Ctrl+N 38 +N
File menu Opens a previously saved Session Ctrl+O 6 +0
Saves the current Session Ctrl+S 6 +S
Undo Ctri+Z #+Z
Edit menu
Redo Ctri+Y B +Y
Closes the active window Ctrl+W ¥ +W
Closes all windows Ctrl+Alt+W 38 +Option+W
Tiles all windows Ctri+T $+T
Cascades all windows Ctri+Alt+T 38 +Option+T
Opens the Master window Ctrl+1 38 +1
Opens the Sends On Fader window Ctrl+2 ¥B+2
Opens the INPUT CH (CH1-16) window Ctrl+Alt+1 38 +Option+1
Opens the INPUT CH (CH17-32) window Ctrl+Alt+2 38 +Option+2
Opens the INPUT CH (CH33-48) window(*) Ctrl+Alt+3 38 +Option+3
Opens the ST IN window Ctrl+Alt+4 38 +Option+4
Windows menu Opens the MIX window Ctrl+Alt+5 38 +Option+5
Opens the MATRIX window Ctrl+Alt+6 36 +Option+6
Opens the STEREO/MONO window Ctrl+Alt+7 &6 +Option+7
Opens the DCA window Ctrl+Alt+8 38 +Option+8(*)
Opens the Selected Channel window Ctrl+3 3 +3
Opens the Library window Ctrl+4 38 +4
Opens the Patch Editor window Ctrl+5 38 +5
Opens the Rack window Ctrl+6 38+6
Opens the Meter window Ctrl+7 38+7
Opens the Group/Link window Ctrl+8 3 +8
Opens the Scene window Ctrl+9 3 +9
Synchronization menu Opens the Re-Synchronize window Ctrl+0 88+0
Library window or Selects consecutive multiple items (memories) Shift+click Shift+click
SCENE MEMORY page | Selects non-consecutive multiple items (memories) Ctrl+click 38 +click
of the Scene window Selects all memories in a section Ctrl+A 3B +A

(*) It can be viewed during offline editing only if “M7CL-48” or “M7CL-48ES” is selected in the System Setup dialog box. It can also be
viewed during online editing for the M7CL-48 or M7CL-48ES.
(**) Modify or cancel the shortcut assignment for the Universal Access Zoom function, or use the number key <8>.
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B L RECALL SAFE page ...occooceree 74
. . SCENE MEMORY page ........... 71
BYPASS eooeeeeeeeeseeeseceeeeeeeeeeesesssne 62 Library Window ......oooeoeeeoocceeeeeee 49 Selovted Chanmel win d(‘)’wg .......... 5
C M Channel selection ............... 30,47
COMPANDER .....cccoeveivrenene 36
CLEAR uuvveeeeeeceeeeceereecenns 51,73 Master WINAOW ..ceevveevnveennveveneennnes 13 COMPRESSOR, EXPANDER ..35
CLEAR ALL ....cceveuee. 52, 69,74-77 MATRIX Bus Setup .....ccceeevvevuenennee 17 DCA GROUP/MUTE GROUP 39
CLOSE ..ooiireeeteereeeeeeeeeeniens 49,71 MATRIX SEND ....cooevviveireecrernens 26 DE=ESSER oo 37
COMMENT ..ooveierreecreeecereeenne 72 MATRIX WindOW ....covveevveeeneeenns 24 EQUALIZER ..o 33,42
Ctrl(#)+click wovvvivreeveeeeerecreereenee 12 Meter WINAOW ..ueeeveveevereernreeeneeeennes 65 Fader oo 39, 46, 48
Ctrl(#)+Shift+Click .....coevevrvennennee. 12 MIX BALANCE ....uvvvvienriieveeennes 63 FROM MIX, ST/MONO ......... 44
MIX Bus Setup .....ceceeevvevvercrrernenennes 17 GATE/DUCKING oo 34
D MIX/CH/ST IN ..oooteeveceeeeeeeeeene 25 HA GAIN/Q/HP oo, 31
DCA fadel oo 28 MIX/MATRIX SEND oo 31 Input channel ......ccesvsvsr 29
DCA EOUP werreerreereseeerreessssceeeren 67 MONO ..ottt 47 INSERT oo 38
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